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ค ำน ำ 

เครื่องรับสัญญาณระบบดาวเทียมน าร่อง จัดเป็นเครื่องมือที่มีความส าคัญในโลกปัจจุบัน และมีการ

น าไปประยุกต์ใช้ในงานด้านต่าง ๆ อย่างกว้างขวาง เช่น ด้านสันทนาการ ด้านส ารวจและการท าแผนที่ ด้าน

ระบบขนส่ง และด้านทรัพยากรและสิ่งแวดล้อม เป็นต้น  

เครื่องรับสัญญาณระบบดาวเทียมน าร่อง Garmin รุ่น GPSMAP® 64s เป็นเครื่องมือที่คณะจัดเตรียม

ไว้บริการแก่นักศึกษา คณาจารย์ และนักวิจัย เพื่อใช้ส าหรับการเรียนการสอน การวิจัย และบริการวิชาการ

ด้านทรัพยากรและสิ่งแวดล้อมของคณะ อย่างไรก็ตาม คู่มือต้นฉบับ (Official manual) ที่บริษัทผู้ผลิต

เผยแพร่มีเนื้อหาที่ออกแบบไว้ส าหรับการใช้งานด้านสันทนาการ จึงยังคงขาดข้อมูลด้านเทคนิคที่มีความส าคัญ

ต่อการน าไปประยุกต์ใช้งานในด้านภูมิสารสนเทศ ด้วยเหตุนี้ “คู่มือการใช้งานเครื่อง GNSS รุ่น GPSMAP® 

64s เบื้องต้น” ฉบับนี้ จึงมุ่งอธิบายและสอดแทรกเนื้อหาและข้อมูลที่มีความเฉพาะเจาะจง และจ าเป็นส าหรับ

การใช้งานที่เกี่ยวข้องกับการเก็บข้อมูลด้านทรัพยากรและสิ่งแวดล้อม ซึ่งสามารถน าความรู้และข้อมูลไป

ประยุกต์ใช้กับระบบภูมิสารสนเทศได้ต่อไป 

ถึงแม้ว่าผู้เขียนมีความตั้งใจเรียบเรียงเนื้อหาในเอกสารฉบับนี้ ให้มีความถูกต้องสมบูรณ์มากที่สุด แต่

ความผิดพลาดที่อาจพบในเอกสาร หรือประเด็นเนื้อหาที่ยังไม่ครอบคลุม ตลอดจนข้อบกพร่องต่าง ๆ อาจจะ

ยังคงมีมาก ด้วยเหตุนี้ ผู้เขียนจึงหวังเป็นอย่างยิ่งว่าจะได้รับข้อเสนอแนะที่เป็นประโยชน์ต่าง ๆ จากผู้อ่าน โดย

ส่งมาที่อีเมล theerawut.chi@mahidol.ac.th เพื่อน าไปใช้ในการพัฒนาปรับปรุงเอกสารให้มีความถูกต้อง

สมบูรณ์มากยิ่งขึ้น 

สุดท้ายนี้ ผู้เขียนขอขอบคุณและขอยกความดีอันเกิดจากการใช้ประโยชน์ของเอกสารฉบับนี้ ให้แก่    

ครูบาอาจารย์ เพื่อนร่วมงาน ครอบครัวของผู้เขียน ตลอดจน นักศึกษาและคณาจารย์ของคณะสิ่งแวดล้อมและ

ทรัพยากรศาสตร์ มหาวิทยาลัยมหิดล ที่เป็นแรงบันดาลใจและมีส่วนช่วยผลักดันให้เกิดการเขียนคู่มือฉบับนี้ 
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คู่มือการใช้งานเครื่อง GNSS รุ่น GPSMAP® 64s เบื้องต้น 

1. ส่วนประกอบของเครื่อง Garmin รุ่น GPSMAP® 64s 
เครื่องรับสัญญาณระบบดาวเทียมน าร่องของบริษัท Garmin รุ่น  GPSMAP® 64s มีส่วนประกอบของ

เครื่องส าหรับการใช้งาน (รูปที่ 1) ดังนี ้
 

 
รูปที่ 1 ส่วนประกอบของเครื่อง GPSMAP® 64s 

(ที่มา: Garmin Ltd. 2014. GPSMAP® 64 Owner’s Manual. p.1) 
 

1. สายอากาศภายในส าหรับรับสัญญาณดาวเทียม 
GPS/GLONASS (Internal GPS/GLONASS 
antenna) 

6. ช่องเสียบการ์ดข้อมูล microSD™ card (อยู่ใต้ช่อง
ใส่แบตเตอรี่) (microSD™ card slot) 

2. ปุ่ม (Keys) 7. ช่องใส่แบตเตอรี ่(Battery compartment) 

3. ปุ่มเปิด/ปิดเครื่อง (Power key) 
8. แกนยึดด้านหลังส าหรับการติดต้ังห่วงเกี่ยวนิรภัย 
(Mounting spine) 

4. พอร์ต Mini-USB (อยู่ใต้ฝาปิด) (Mini-USB port) 
9. แหวนล็อกฝาครอบแบตเตอรี ่(Battery cover D-
ring) 

5.  ช่องต่อสายอากาศภายนอกส าหรับรับสญัญาณ
ดาวเทียม GPS (อยู่ใต้ฝาปิด) (MCX connector for 
GPS antenna) 
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2. การติดตั้งและต้ังค่าแบตเตอรี่ 

เครื่องรุ่น GPSMAP® 64s ใช้แบตเตอรี่ขนาด AA จ านวน 2 ก้อน1 (รูปที่ 2) วิธีการติดตั้งแบตเตอรี่ มี
ดังนี้ 

1) หมุนแหวนรูปตัว D ทวนเข็มนาฬิกา และดึงขึ้นเพื่อเปิดฝาครอบออก 
2) ใส่แบตเตอรี่ให้ขั้วถูกต้อง 
3) ปิดฝาครอบแบตเตอรี่ และหมุนแหวนรูปตัว D ตามเข็มนาฬิกา 
4) กดปุ่ม  ค้างไว ้เพื่อเปิดเครื่อง 
5) กดปุ่ม MENU และกดปุ่ม MENU อีกครั้งเพื่อเปิดเมนูหลัก (Main Menu) 
6) เลือก ตั้งค่า > ระบบ > ประเภทแบตเตอรี่ (Setup > System > Battery Type) 
7) เลือก Alkaline, Lithium, Rechargeable NiMH หรือ Precharged NiMH ซึ่งขึ้นอยู่กับประเภท

ของแบตเตอรี่ที่ใช้ 
 

 
 

รูปที่ 2 การติดตั้งแบตเตอรีข่องเครื่อง GPSMAP® 64s 
(ที่มา: Garmin Ltd. 2014. GPSMAP® 64 Owner’s Manual. p.1) 

 

3. การเปิด/ปิดอปุกรณ ์
กดปุ่ม  ค้างไว ้เพื่อเปิดหรือปิดเครื่อง 

4. การใช้งานปุ่มของเครื่อง 
ปุ่มของเครื่องแต่ละปุ่ม (รูปที่ 3) มีหน้าที่และวิธีการใช้งานดังนี้ 
 

                                           
1
 การใช้แบตเตอรี่แบบแอลคาไลน์ในสภาพแวดล้อมการใช้งานที่มีอุณหภูมิสูงมาก อาจจะท าให้ถ่านแตกฉีกขาดได้ หรือการใช้แบตเตอรี่แบบ

แอลคาไลน์ในสภาพแวดล้อมการใช้งานที่มีอุณหภูมิต่ ากว่าจุดเยือกแข็ง จะท าให้ความจุแบตเตอรี่ลดลง ดังนั้น เมื่อใช้งานเครื่องขณะที่มี
อุณหภูมิต่ ากว่าจุดเยือกแข็ง ควรใช้แบตเตอรี่แบบลิเธียม 
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รูปที่ 3 ปุ่มของเครื่อง GPSMAP® 64s 

(ที่มา: Garmin Ltd. 2014. GPSMAP® 64 Owner’s Manual. p.2) 
 

 
 
 
 
 
 

ชื่อปุ่ม หน้าที่และวิธกีารใช้งาน 

1. FIND  กดปุ่ม FIND เพื่อเปิดเมนูค้นหา (Search menu) 

2. MARK  กดปุ่ม MARK เพื่อบันทึกต าแหน่งปัจจุบันของผู้ใช้เป็น Waypoint 

3. QUIT 
 กดปุ่ม QUIT เพื่อยกเลิกหรือย้อนกลับไปยังเมนู (Menu) หรือหน้าจอ (Page) 

ก่อนหน้านี้ 

4. ENTER 
 กดปุ่ม ENTER เพื่อเลือกตัวเลือก (Option) หรือเพื่อตกลงเพ่ือยอมรับค ายืนยัน

หรือข้อความที่แจ้งข้อมูลต่าง ๆ 

5. MENU 
 กดปุ่ม MENU เพื่อเปิดเมนูตัวเลือก (Options menu) ของหน้าจอที่ก าลังใช้

งานอยู ่ณ ปัจจุบัน 

 กดปุ่ม MENU สองครั้ง เพื่อเปิดเมนูหลัก (Main Menu) 

6. PAGE  กดปุ่ม  PAGE  เพื่อเลื่อนไปเปิดหน้าจอหลักต่าง ๆ  

7.  
 กดปุ่ม  เพื่อเลื่อนไปเลือกตัวเลือก หรือเพ่ือเลื่อนตัวชี้ต าแหน่งบน

แผนที่ (Map cursor) 

8. IN  กดปุ่ม IN เพื่อซูมแผนที่เข้า 

9. OUT  กดปุ่ม OUT เพื่อซูมแผนที่ออก MAHID
OL
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5. การตั้งค่าอุปกรณ์ที่จ าเปน็ส าหรับการท างานหลักของเครื่อง 

5.1 การตั้งค่าระบบ 
เลือก ตั้งค่า > ระบบ (Setup > System) ซึ่งมีตัวเลือกส าหรับการตั้งค่าระบบ ดังนี้ 

รายการ ตัวเลือก ค าอธิบาย 

ระบบดาวเทียม 
(GPS) 

(Satellite System) 

GPS เลือกท างานกับระบบ GPS เท่านั้น 
GPS + GLONASS2 เลือกท างานกับระบบ GPS และ GLONASS 

โหมดสาธิต 
(Demo Mode) 

เลือกท างานในโหมดสาธิต (ปิดการรับสัญญาณดาวเทียม ซึ่ง
อาจจะใช้ในกรณีที่ต้องการต้ังค่าการใช้งานเครื่องในขณะที่
อยู่ภายในอาคาร เป็นต้น) 

WASS 
(WASS/EGNOS) 

เปิดใช้งาน 
(On) 

เปิดการใช้งานระบบ WAAS 

ปิด3 
(Off) 

ปิดการใช้งานระบบ WAAS 

ภาษา 
(Language) 

ตัวเลือกภาษา 
เลือกใช้ภาษาส าหรับแสดงเมนูหรือค าสั่งต่าง ๆ ของเครื่อง 
เช่น ภาษาอังกฤษ หรือภาษาไทย 

การเช่ือมต่อ 
(Interface) 

Garmin Spanner 
ใช้ส าหรับเช่ือมต่อกับโปรแกรมจัดท าแผนทีท่ี่รองรับ
มาตรฐาน NMEA 0183 ด้วยช่องทางข้อมูลอนุกรมเสมือน 
(Virtual serial port) 

Garmin Serial 
ใช้ส าหรับเช่ือมต่อและแลกเปลี่ยนข้อมูล Waypoint, 
Route, Track ด้วยรูปแบบข้อมูล Garmin (Garmin 
format) 

NMEA In/Out 
ใช้ส าหรับเช่ือมต่อและแลกเปลี่ยนข้อมูลมาตรฐาน NMEA 
0183 

Text Out 
ใช้ส าหรับเช่ือมต่อเพื่อส่งออกข้อมูลต าแหน่งและความเร็ว
ด้วยรูปแบบแอสกี (ASCII text) 

                                           
2
 โดยทั่วไป การรับสัญญาณดาวเทียมได้จากทั้งสองระบบ ท าให้การค านวณมีความถูกต้องและรวดเร็วขึ้น ดั้งน้ัน ผู้ใช้จึงควรเลือกตัวเลือกนี้ 

3
 ระบบ WAAS (Wide Area Augmentation System) เป็นระบบช่วยเสริมการท างาน (Augmentation System) ในประเภท Space-

Based Augmentation System (SBAS) ที่พัฒนาขึ้นโดยประเทศสหรัฐอเมริกา ใช้ส าหรับเพิ่มประสิทธิภาพระบบ GPS ท าให้ความเชื่อถือได้ 
(Integrity) ในการใช้งานที่เกี่ยวกับความปลอดภัย และความถูกต้องของการค านวณต าแหน่งมีมากขึ้น อย่างไรก็ตาม ระบบ WAAS มีบริการ
ครอบคลุมเฉพาะพื้นที่บริเวณอเมริกาเหนือเท่านั้น ดังนั้น การเลือกเปิด/ปิดการใช้งานตัวเลือกนี้ส าหรับผู้ใช้งานในประเทศไทย จึงไม่มีผลต่อ
การใช้งานเครื่อง 

MAHID
OL



5 
 

รายการ ตัวเลือก ค าอธิบาย 

RTCM 

ใช้ส าหรับเช่ือมต่อเพื่อรับข้อมูลการหาต าแหน่งด้วย
ดาวเทียมจีพีเอสแบบสัมพัทธ์ (Differential Global 
Positioning System: DGPS) ด้วยรูปแบบข้อมูล SC-104 
(SC-104 format) 

ประเภทแบตเตอรี่ 
(Battery Type) 

Alkaline เลือกใช้งานแบตเตอรี่แบบ Alkaline 
Lithium เลือกใช้งานแบตเตอรี่แบบ Lithium 

Traditional NiMH เลือกใช้งานแบตเตอรี่แบบ NiMH ที่ประจุไฟใหม่ได ้

Precharged NiMH 
เลือกใช้งานแบตเตอรี่แบบ NiMH ที่ประจุไฟใหม่ได ้และมี
อัตราการปล่อยประจุเองต่ า (Low self-discharge rate) 

5.2 การตั้งค่าเวลา 
เลือก ตั้งค่า > เวลา (Setup > Time) ซึ่งมตีัวเลือกส าหรับการตั้งค่าเวลา ดังนี้ 

รายการ ตัวเลือก ค าอธิบาย 

รูปแบบเวลา 
(Time Format) 

12 ชม. 
(12-Hour) 

เลือกแสดงรูปแบบเวลา 12 ช่ัวโมง 

24 ชม. 
(24-Hour) 

เลือกแสดงรูปแบบเวลา 24 ช่ัวโมง 

โซนเวลา 
(Time Zone) 

ตัวเลือกโซนเวลา4 เลือกโซนเวลาที่ผู้ใช้ต้องการ 

5.3 การตั้งค่ารูปแบบระบบพิกัด 
เลือก ตั้งค่า > รูปแบบต าแหน่ง (Setup > Position Format) ซึ่งมีตัวเลือกส าหรับการตั้งค่า

รูปแบบต าแหน่ง ดังนี ้
รายการ ตัวเลือก ค าอธิบาย 

รูปแบบต าแหน่ง 
(Position Format) 

ตัวเลือกรูปแบบต าแหน่ง 
เลือกแสดงระบบพิกัดที่ต้องการ เช่น ระบบพิกัด
ภูมิศาสตร์ (ละติจูด ลองจิจูด) หรือระบบพิกัดยูทีเอ็ม  

Map Datum ตัวเลือก Map Datum5 เลือกมูลฐาน 

                                           
4
 โดยปกติแล้ว โซนเวลาที่เลือกควรจะเป็นโซนเวลาปัจจุบันของผู้ใช้ ส าหรับประเทศไทย ใช้โซนเวลา Thailand Time Zone UTC+07:00 

ทั้งน้ี ผู้ใช้สามารถเลือกตัวเลือก อัตโนมัต ิ(Automatic) เพื่อตั้งค่าโซนเวลาแบบอัตโนมัติ โดยอ้างอิงกับต าแหน่งของเครื่องได้ 
5
 มูลฐาน จัดเป็นกรอบอ้างอิงที่ใช้ในระบบพิกัด ในปัจจุบัน มูลฐานสากลที่ใช้ในการแผนที่ ภูมิมาตรศาสตร์ หรือการน าร่อง คือ World 

Geodetic System 1984 (WGS84) ซึ่งเป็นมูลฐานเดียวกับที่ใช้ในแผนที่ภูมิประเทศ ล าดับชุด L7018 ทั้งนี้ การใช้งานเครื่องรับสัญญาณระบบ
ดาวเทียมน าร่องร่วมกับแผนที่นั้น มูลฐานของทั้งเครื่องและแผนที่ต้องเหมือนกัน ในกรณีที่มูลฐานแตกต่างกัน ผู้ใช้จ าเป็นต้องตั้งค่ามูลฐาน
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รายการ ตัวเลือก ค าอธิบาย 
Map Spheroid ตัวเลือก Map Spheroid6 เลือกสเฟียรอยดข์องแผนที ่

5.4 การตั้งค่าหน่วยวัด 
เลือก ตั้งค่า > หน่วย (Setup > Units) ซึ่งมีตัวเลือกส าหรับการตั้งค่ารูปแบบต าแหน่ง ดังนี ้

รายการ ตัวเลือก ค าอธิบาย 

ระยะทาง/ความเร็ว 
(Distance and 

Speed) 

การเดินเรือ7 (nm, kt, ft) 
(Nautical (nm, kt, ft)) 

เลือกหน่วยแบบการเดินเรือ ที่มีหน่วยวัดความยาวเป็น
ฟุต 

การเดินเรือ (nm, kt, m) 
(Nautical (nm, kt, m)) 

เลือกหน่วยแบบการเดินเรือ ที่มีหน่วยวัดความยาวเป็น
เมตร 

สถานะ8 
(Statute) 

เลือกหน่วยแบบสถานะ (ไมล์บก) 

ระบบเมตริก 
(Metric) 

เลือกหน่วยในระบบเมตริก 

หลา 
(Yards) 

เลือกหน่วยแบบหลา 

ความสูง (ความเร็วใน
แนวดิ่ง) 

(Elevation 
(Vertical Speed)) 

ฟุต 
(Feet (ft/min)) 

เลือกหน่วยแบบฟุตต่อนาที 

ฟุต 
(Feet (ft/hr)) 

เลือกหน่วยแบบฟุตต่อชั่วโมง 

เมตร ต่อ นาท ี
(Meters (m/min)) 

เลือกหน่วยแบบเมตรต่อนาที 

เมตร ต่อ วินาท ี
 (Meters (m/sec)) 

เลือกหน่วยแบบเมตรต่อวินาที 

เมตร ต่อ ช่ัวโมง 
 (Meters (m/hr)) 

เลือกหน่วยแบบเมตรต่อชั่วโมง 

                                                                                                                                   
ของเครื่องให้ตรงกับมูลฐานของแผนที่ เช่น ผู้ใช้ต้องตั้งค่ามูลฐานเครื่องเป็น Indian 1975 ถ้าต้องการใช้งานเครื่องร่วมกับแผนที่ภูมิประเทศ 
ล าดับชุด L7017 ทีใ่ช้มูลฐาน Indian 1975 เป็นต้น 
6
 สเฟียรอยด์ หรือ สเฟียรอยด์อ้างอิง (reference spheroid) หรือ ทรงรีอ้างอิง (reference ellipsoid) หมายถึง รูปทรงอ้างอิงที่ใช้ในมูลฐาน ส าหรับ

มูลฐาน WGS84 ใชท้รงรีอ้างอิง คือ WGS84  และมูลฐาน Indian 1975 ใชท้รงรีอ้างอิง คือ Everest 1830 
7
 ในที่น้ีตัวเลือกหน่วย “การเดินเรือ” ในเครื่อง เป็นค าแปลมาจากเมนูภาษาอังกฤษว่า Nautical ซึ่งหมายถึง Nautical mile หรือ ไมล์ทะเล 

8
 ตัวเลือกหน่วย “สถานะ” เป็นค าแปลมาจากเมนูภาษาอังกฤษว่า Statute ซึ่งหมายถึง Statute mile หรือ Land mile หรือไมล์บก  
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รายการ ตัวเลือก ค าอธิบาย 

ความลึก 
(Depth) 

ฟุต 
(Feet) 

เลือกหน่วยแบบฟุต   

ฟาทอม 
(Fathoms) 

เลือกหน่วยแบบฟาทอม 

เมตร 
(Meters) 

เลือกหน่วยแบบเมตร 

อุณหภูม ิ
(Temperature) 

เซลเซียส 
(Celsius) 

เลือกหน่วยแบบเซลเซียส 

ฟาเรนไฮต์ 
(Fahrenheit) 

เลือกหน่วยแบบฟาเรนไฮต์ 

ความกดอากาศ
(Pressure) 

นิ้ว (Hg) 
(Inches (Hg)) 

เลือกหน่วยแบบนิ้ว (Hg) 

Millimeters (Hg) เลือกหน่วยแบบ Millimetres (Hg) 
Millibars เลือกหน่วยแบบ Millibars 

Hectopascals เลือกหน่วยแบบ Hectopascals 

6. การตั้งค่าอุปกรณ์ทั่วไป 

6.1 การตั้งค่าการแสดงผล 
เลือก ตั้งค่า > แสดง (Setup > Display) ซึ่งมีตัวเลือกส าหรับการตั้งค่ารูปแบบต าแหน่ง ดังนี้ 

รายการ ตัวเลือก ค าอธิบาย 

ปิด backlight 
(Backlight 
Timeout) 

ตัวเลือกระยะเวลา 

ปรับความยาวนานของไฟแสงสว่างหน้าจอก่อนที่หน้าจอ
จะดับลง ซึ่งมีตัวเลือก ต้ังแต่ เปิดใช้ต่อไป (Stays On), 
15 วินาท ี(15 Seconds), 30 วินาที (30 Seconds), 1 
นาท ี(1 Minute), และ 2 นาที (2 Minutes) 

ประหยัดแบตเตอรี ่
(Battery Save) 

เปิดใช้งาน 
(On) 

เปิดการใช้งานโหมดประหยัดพลังงาน ซึ่งจะท าใหห้น้าจอ
ปิดลงหลังจากที่ไฟแสงสว่างหน้าจอไดป้ิดลง 

ปิด 
(Off) 

ปิดการใช้งานโหมดประหยัดพลังงาน ซึ่งจะท าให้ห้าจอ
ยังแสดงผลอยู่ แม้ว่าไฟแสงสว่างหน้าจอได้ปิดลง MAHID
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รายการ ตัวเลือก ค าอธิบาย 

ส ี
(Colors) 

โหมด 
(Mode) 

เลือกโหมดการต้ังพ้ืนหลังแบบสว่าง (กลางวัน หรือ Day) 
และพื้นหลังแบบมืด (กลางคนื หรือ Night) หรือสลับ
เปลี่ยนระหว่างระบบทั้งสองแบบอัตโนมัติ (อัตโนมัต ิ
หรือ Auto) ตามเวลาที่ดวงอาทิตย์ขึ้นหรือตก โดยอ้างอิง
กับต าแหน่งปัจจุบันของผู้ใช้ 

สีพื้นหลังตอนกลางวัน 
(Day Background Color) 

เลือกสีพื้นหลังตอนกลางวัน 

สีกลางวัน 
(Day Highlight Color) 

เลือกสีของแถบเลือกตอนกลางวัน 

สีพื้นหลังตอนกลางคืน 
(Night Background Color) 

เลือกสีพื้นหลังตอนกลางคืน 

สีกลางคืน 
(Night Highlight Color) 

เลือกสีของแถบเลือกตอนกลางคืน 

หลัก, ตั้งค่า, หาสไตล ์
(Main, Setup, Find 

Style) 

Grid (12 รายการ) 
(Grid (12 Items)) 

เลือกแสดงรายการแบบกริด จ านวน 12 รายการ ใน
จอแสดงผล ท าให้ขนาดสัญรูป (Icon) มีขนาดเล็ก 

Grid (6 รายการ) 
(Grid (6 Items)) 

เลือกแสดงรายการแบบกริด จ านวน 6 รายการ ใน
จอแสดงผล 

แสดง (7 รายการ) 
(List (7 Items)) 

เลือกแสดงแบบรายการ จ านวน 7 รายการ ใน
จอแสดงผล 

บันทึกหน้าจอ
(Screen Capture) 

เปิดใช้งาน 
(On) 

เลือกเปิดใช้งานการบันทึกภาพหน้าจอ 

ปิด 
(Off) 

เลือกปิดใช้งานการบันทึกภาพหน้าจอ 

6.2 การจัดล าดับรายการในหน้าเมนูหลักและเมนูตั้งคา่ (Changing item order) 
การจัดล าดับรายการในหน้าเมนูหลัก (Main Page) หรือหน้าตั้งค่า (Setup Page) สามารถท าให้

การเข้าถึงการตั้งค่าที่ต่าง ๆ ที่มีการใช้งานบ่อย ๆ มีความสะดวกมากขึ้น การจัดล าดับรายการในหน้าเมนูหลัก 
หรือหน้าตั้งค่า มีวิธีการ ดังนี ้

1) เลือกหน้าเมนูหลักหรือหน้าตั้งค่า 
2) กดปุ่ม MENU 
3) กดปุ่ม ENTER เพื่อเลือก เปลี่ยนล าดับรายการ (Change Item Order) 
4) ใช้ปุ่มเลื่อน (ปุ่มลูกศรขึ้น-ลง) ไปเลือกรายการที่ต้องการจัดล าดับ 
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5) กดปุ่ม ENTER 
6) เลือก เลื่อน (Move) และกดปุ่ม ENTER (สีของข้อความของรายการที่ก าลังจะถูกเลื่อนจะเป็นสี

แดง) 
7) เลื่อนรายการไปยังล าดับที่ต้องการ และกดปุ่ม ENTER 

6.3 การตั้งค่าหน้าดาวเทียม 
หน้าดาวเทียม (Satellite Page) เป็นส่วนที่ใช้แสดง 1) ต าแหน่งปัจจุบัน 2) ความแม่นย าของค่า

พิกัดที่เครื่องสามารถค านวณได้ 3) ต าแหน่งดาวเทียม และ 4) ความแรงของสัญญาณ ผู้ใช้สามารถตั้งค่าหน้า
ดาวเทียมได้โดย เลือก เมนูหลัก > ดาวเทียม (Main Menu > Satellite) เพื่อไปยังหน้าดาวเทียม และกดปุ่ม 
MENU ซึ่งมีตัวเลือกส าหรับการตั้งค่าหน้าดาวเทียม ดังนี ้

 
รายการ ตัวเลือก ค าอธิบาย 

การเปิด/ปิดการรับ
สัญญาณดาวเทียม 

ใช้พร้อมเปิด GPS 
(Use Satellite System) 

เลือกเปิดรับสัญญาณดาวเทยีม เพื่อใช้งานจริง 

ใช้พร้อมปิด GPS 
(Use Demo Mode) 

เลือกปิดการรับสัญญาณดาวเทียม เพื่อใชเ้ครื่องในโหมด
สาธิต 

การก าหนดมุมมอง
ของดาวเทียม 

หันแผนที่ตามทิศเหนือ 
(North Up) 

เลือกเปลี่ยนมมุมองของดาวเทียมให้หันไปในเหนือ 

หันไปตามทิศที่รถวิ่ง 
(Track Up) 

เลือกเปลี่ยนมมุมองของดาวเทียมให้หันไปในทิศทางที่
ตรงกับ track ปัจจุบันของผู้ใช ้

การก าหนดสีให้กับ
ดาวเทียมและแถบ

ความแรงของ
สัญญาณดาวเทียม 

สีเดี่ยว 
(Single Color) 

เลือกให้ดาวเทียมและแถบความแรงของสัญญาณ
ดาวเทียม แสดงแบบสีเดียว 

หลากส ี
(Multicolor) 

เลือกให้ดาวเทียมและแถบความแรงของสัญญาณ
ดาวเทียม แสดงแบบหลายส ี

การก าหนดต าแหน่ง
บนแผนที ่

ตั้งต าแหน่งบนแผนที่9 
(Set Location On 

Map) 

ใช้ส าหรับก าหนดต าแหน่งของผู้ใช้ลงบนแผนที่ โดยใช้ 
ปุ่มเลื่อน (ปุ่มลูกศรขึ้น-ลง ซ้าย-ขวา) เพื่อเลื่อนแผนที่
และ/หรือปุ่ม IN หรือ OUT เพื่อซูมเข้าและซูมออก  

                                           
9
 ในกรณีที่อยู่ในโหมด ใช้พร้อมเปิด GPS (Use Satellite System) และเครื่องไม่สามารถค้นหาหรือรับสัญญาณดาวเทียมได้ การก าหนด

ต าแหน่งปัจจุบันของผู้ใช้แผนที่ด้วยค าสั่ง ตั้งต าแหน่งบนแผนที่  (Set Location On Map)  จะช่วยให้เครื่องรับสัญญาณดาวเทียมได้รวดเร็ว
ขึ้น ในกรณีที่อยู่ในโหมด ใช้พร้อมปิด GPS (Use Demo Mode) การใช้ค าสั่ง ตั้งต าแหน่งบนแผนที่  (Set Location On Map)  จะเป็นการ
จ าลองต าแหน่งปัจจุบันของผู้ใช้ 
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รายการ ตัวเลือก ค าอธิบาย 

การลบข้อมูล
ดาวเทียมปัจจุบัน 

ต าแหน่ง AutoLocate 
(AutoLocate Position) 

เมื่อเครื่องแสดงข้อความว่า “ไม่สามารถรับสัญญาณได้ 
ต้องการหาสัญญาณต่อไปหรือไม”่ (“Trouble finding 
satellites. Continue searching?”) ซึ่งเกิดจากข้อมูล
ดาวเทียมที่มอียู่ในเครื่อง ไม่สามารถใช้ค้นหาสัญญาณ
และค านวณต าแหน่งได ้ผู้ใช้ตอ้งใช้ค าสั่ง ต าแหน่ง 
AutoLocate (AutoLocate Position) เพื่อลบข้อมูล
ดาวเทียมที่มีอยู่ในเครื่องออกไป และรับข้อมูลดาวเทียม
ใหม่มาใชแ้ทน จึงท าให้เครื่องสามารถค านวณหา
ต าแหน่งได้อย่างถูกต้อง 

6.4 การตั้งค่าแผนที ่
เลือก ตั้งค่า > แผนที ่(Setup > Map) ซึ่งมีตัวเลือกส าหรับการตั้งค่าแผนที่ ดังนี ้

รายการ ตัวเลือก ค าอธิบาย 

แนวแผนที ่
(Orientation) 

หันทิศเหนือ 
(North Up) 

แสดงแผนที่โดยหันชี้ไปยังทิศเหนือ 

หันทิศรถวิ่ง 
(Track Up) 

แสดงแผนที่โดยหันชี้ไปยังทิศทางของ Track 

มุมมองรถยนต ์
(Automotive Mode) 

แสดงมุมมองแบบรถยนต์ และแผนที่หันชี้ไปยังทิศทาง
ของการเดินทาง (Direction of travel) ซึ่งมีลักษณะ
มุมมองการใชง้านแผนที่คล้ายกับเครื่องรับสัญญาณ
ระบบดาวเทียมน าร่องที่ติดต้ังในรถยนต์ 

ข้อความแนะน า 
(Guidance Text) 

ไม่เคย 
(Never) 

เลือกไม่ต้องการแสดงข้อความแนะน าบนแผนที ่

แสดงขณะน าทาง 
(When Navigating) 

เลือกแสดงข้อความบนแผนที่ขณะน าทาง 

เสมอ 
(Always) 

เลือกแสดงข้อความบนแผนที่เสมอ 

Data Fields 

ไม่แสดง 
(0) 

เลือกไม่แสดงเขตข้อมูล (Data field) บนแผนที ่

ช่องใหญ่ 
(1 large) 

เลือกจ านวนและขนาดของเขตข้อมูล (Data field) ที่
ต้องการแสดงบนแผนที ่

MAHID
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รายการ ตัวเลือก ค าอธิบาย 
2 ช่องเล็ก 
(2 small) 

เลือกแสดงเขตข้อมูล 2 ช่องเล็ก 

4 ช่องเล็ก 
(4 small) 

เลือกแสดงเขตข้อมูล 4 ช่องเล็ก 

Dashboard 

เลือกประเภทของแผงหน้าปัด (Dashboard) ที่ต้องการ
แสดงบนแผนที่ ได้แก่ สันทนาการ (Recreational), 
ขับเคลื่อนด้วยตนเอง (Automotive), นาฬิกาจับเวลา 
(Stopwatch), เข็มทิศ (Compass), หรือ Geocaching 

ก าหนดเอง 
(Custom) 

เลือกก าหนดจ านวนและขนาดของเขตข้อมูลด้วยตนเอง
นอกเหนือจากที่เครื่องก าหนดค่าเตรียมไว้ให้เบื้องต้น  

ตั้งค่าแผนที่อื่น ๆ 
(Advanced Map 

Setup) 

ปรับซูมอัตโนมตัิ 
(Auto Zoom) 

เลือก เปิดใช้งาน (On) ระดับการซูมที่เหมาะสมโดย
อัตโนมัติ เพื่อการใช้แผนที่อย่างมีประสิทธิภาพที่สุด เมื่อ
เลือก ปิด (Off) ผู้ใช้ต้องซูมแผนทีเ่ข้าหรือออกด้วยตนเอง 

ระดับการซูม 
(Zoom Levels) 

เลือกระดับการซูมส าหรับรายการต่าง ๆ บนแผนที่ โดยมี
ตัวเลือก คือ จดุสนใจทั้งหมด (Map Points), 
Waypoint ของผู้ใช ้(User Waypoints), Geocaches, 
แสดงชื่อถนน (Street Label), และ สิ่งปกคลุมพื้นผิว 
(Land Cover) โดยตัวเลือกระดับการซูมที่ผู้ใช้สามารถ
เลือกได้ คือ ปดิ (Off), อัตโนมัติ (Auto) และค่าการซูม
ในระดับต่าง ๆ 

ขนาดตัวอักษร 
(Text Size) 

เลือกขนาดตัวอักษรส าหรับรายการต่าง ๆ บนแผนที ่โดย
มีตัวเลือก คือ จุดสนใจทั้งหมด (Map Points), 
waypoint ของผู้ใช ้(User Waypoints), แสดงชื่อถนน 
(Street Label), และ สิ่งปกคลุมพื้นผิว (Land Cover) 
โดยตัวเลือกขนาดตัวอักษรที่ผู้ใช้สามารถเลอืกได้ คือ ไม่
มี (None), เล็ก (Small), ปานกลาง (Medium), และ 
ใหญ ่(Large) (เฉพาะช่ือถนนมเีพียง 3 ตัวเลือก คือ เล็ก 
ปานกลาง ใหญ่) MAHID
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รายการ ตัวเลือก ค าอธิบาย 

รายละเอียด 
(Detail) 

เลือกระดับรายละเอียดที่แสดงบนแผนที่ โดยมีตัวเลือก 
คือ ที่สุด (Most), มากขึ้น (More), ปกต ิ(Normal), 
น้อยลง (Less), และ น้อยทีสุ่ด (Least) ทั้งนี้การแสดง
รายละเอียดของแผนที่ที่มากขึ้น มีผลให้การแสดงแผนที่
ช้าลง 

Shaded Relief 

แสดงระดับความสูงต่ าของแผนที่ (ถ้ามี) หรือปิดการ
แสดง โดยมีตัวเลือก คือ แสดงเมื่อพร้อม (Show if 
Available), ไม่ต้องแสดง (Do Not Show) และ 
อัตโนมัต ิ(Auto) 

ข้อมูลแผนที ่
(Map information) 

เลือกแผนที ่
(Select Map) 

เลือก ใช้งาน (Enable) หรือ ไม่ใช้งาน (Disable) การใช้
งานแผนที่ที่ติดตั้งอยู่ในอุปกรณ์ (ผู้ใช้สามารถซื้อข้อมลู

แผนที่เสริม เชน่ BirdsEye™ satellite imagery, 
BlueChart® g2, TOPO, และ City Navigator® 
เพิ่มเติม เพื่อติดต้ังในอุปกรณ์ ซึ่งจะท าให้เครื่องมีข้อมูล
ต าแหน่งของสถานที่หรือสิ่งต่าง ๆ เพิ่มมากขึ้น 

6.5 การจัดการล าดับหน้า (Page Sequence) 
เมื่อผู้ใช้กดปุ่ม PAGE จะปรากฏแถบขึ้นในหน้าจอ ที่ใช้ส าหรับการเลือกไปหน้าถัดไป (Next Page) 

ในรายการหน้า หรือกดปุ่ม QUIT เพื่อย้อนกลับไปยังหน้าที่ผ่านมา (Previous Page) 10 ซึ่งการจัดการล าดับ
หน้าได้อย่างเหมาะสม จะช่วยให้การใช้งานการตั้งค่าและค าสั่งต่าง ๆ มีความสะดวกรวดเร็วมากยิ่งขึ้น การ
จัดการล าดับหน้ามีรายละเอียดดังนี ้

  การเพ่ิมหน้า 
ผู้ใช้สามารถเพิ่มหน้า (Page) เข้าในรายการเมน ูด้วยขั้นตอนดังนี ้
1) เลือก ตั้งค่า > ล าดับหน้า (Setup > Page Sequence) 
2) เลือก เพิ่มหน้า (Add Page) 
3) เลือกหน้าทีต่้องการเพ่ิม และกดปุ่ม ENTER 

                                           
10

 รายการหน้าโดยปริยาย (Default Page list) มี 5 หน้า ประกอบด้วย เมนูหลัก (Main Menu), แผนที่ (Map), เข็มทิศ (Compass), Trip Computer,  

Profile ผังความสูง (Elevation Plot) นอกจากนี้ ยังมีหน้าที่สามารถเพิ่มไปยังรายการหน้าได้อีก ได้แก่ Adventures, Geocaches, Photo Viewer, Sight 

‘N Go,  VIRB Remote, การค านวณพื้นที่ (Area Calculation), การเฉลี่ย Waypoint (Waypoint Avg.), จัดการ Track (Track Manager), จัดการ Waypoint 

(Waypoint Mgr.), ดาวเทียม (Satellite), ตั้งค่า (Setup), นาฬิกาจับเวลา (Stopwatch), นาฬิกาปลุก (Alarm Clock), ปฏิทิน (Calendar), พระอาทิตย์และ
พระจันทร์ (Sun and Moon), ล่าสัตว์และตกปลา (Hunt and Fish), วางแผนเส้นทาง (Route Planner), เครื่องคิดเลข (Calculator), เปลี่ยน Profile 

(Profile Change), เส้นทางท่ีใช้งาน (Active Route), เสียงเตือนจุดใกล้เคียง (Proximity Alarms), แชร์แบบ (Share Wirelessly) 

MAHID
OL



13 
 

  การเปลี่ยนล าดับหน้า  
1) เลือก ตั้งค่า > ล าดับหน้า (Setup > Page Sequence) 
2) เลือกหน้าทีต่้องการเปลี่ยนล าดับ  
3) เลือก เลื่อน (Move) ข้อความของหน้าจะมีสีแดง แสดงว่าก าลังถูกเลือก 
4) เลือกต าแหน่งของหน้าใหม่ และกดปุ่ม ENTER 

  การลบหน้า 
1) เลือก ตั้งค่า > ล าดับหน้า (Setup > Page Sequence) 
2) เลือกหน้าทีต่้องการลบ 
3) เลือก ลบ (Remove) 

 การแทรกหน้า 
1) เลือก ตั้งค่า > ล าดับหน้า (Setup > Page Sequence) 
2) เลือกต าแหน่งของหน้าที่ต้องการแทรก และกดปุ่ม ENTER 
3) เลือก แทรก (Insert) 
4) เลือกหน้าทีต่้องการแทรก และกดปุ่ม ENTER 

6.6 การตั้งข้อมูลใหม่ (Resetting) 
ผู้ใช้สามารถตั้งข้อมูลใหม่ให้กับเครื่องได้ ทั้งข้อมูลการเดินทาง การลบ Waypoint ทั้งหมด การลบ 

Track ปัจจุบัน  หรือการใช้ค่าโรงงาน ซึ่งการต้ังค่าข้อมูลใหม่มีรายละเอียดดังนี ้

  การตั้งข้อมูลใหม ่(Resetting data) 
1) เลือก ตั้งค่า > ตั้งค่าใหม่ (Setup > Reset) 
2) เลือกรายการเพื่อตั้งค่าใหม่ ดังนี ้
 

รายการ ตัวเลือก ค าอธิบาย 

ตั้งข้อมูลเดินทาง
ใหม่11 

(Reset Trip Data) 

ใช ่
(Yes) 

เลือกตั้งข้อมูลการเดินทางใหม่ 

ไม่ใช ่
(No) 

ไม่เลือกตั้งข้อมูลการเดินทางใหม ่

ลบ Waypoints 
ทั้งหมด 

ใช ่
(Yes) 

เลือกลบข้อมูล Waypoints ทั้งหมด 

                                           
11

 ข้อมูลการเดินทาง (Trip computer) เป็นข้อมูลเกี่ยวกับการเดินทางขณะที่ผู้ใช้ใช้งานอุปกรณ์ เช่น ความเร็วปัจจุบัน ความเร็วเฉลี่ย ความเร็ว

สูงสุด และระยะทาง เป็นต้น 
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รายการ ตัวเลือก ค าอธิบาย 
(Delete All 
Waypoints) 

ไม่ใช ่
(No) 

ไม่เลือกลบข้อมูล Waypoints ทั้งหมด 

ลบ Track ปัจจุบัน 
(Clear Current 

Track) 

ใช ่
(Yes) 

เลือกลบข้อมูล Track ปัจจุบัน ทั้งหมด 

ไม่ใช ่
(No) 

ไม่เลือกลบข้อมูล Track ปัจจุบัน ทั้งหมด 

Clear Track and 
Trip Data 

ใช ่
(Yes) 

เลือกเลือกลบข้อมูล Track ปัจจุบัน และข้อมูลการ
เดินทาง ทั้งหมด 

ไม่ใช ่
(No) 

ไม่เลือกลบข้อมูล Track ปัจจุบัน และข้อมูลการเดินทาง 
ทั้งหมด 

ตั้งค่าทั้งหมดใหม่ 
(Reset All 
Settings) 

ใช ่
(Yes) 

เลือกใช้การตั้งค่าเดิมของเครื่องที่ก าหนดมาจากโรงงาน 
(Factory default) 

ไม่ใช ่
(No) 

ไม่เลือกใช้การตั้งค่าเดิมของเครื่องที่ก าหนดมาจาก
โรงงาน (Factory default) 

 

  การเรียกคืนค่าที่ตั้งไว้โดยเฉพาะให้เป็นค่าเริ่มต้น (Specific settings) 
1) เลือก ตั้งค่า (Setup) 
2) เลือกรายการที่ต้องการตั้งค่าใหม ่
3) กดปุ่ม MENU > ใช้ค่าโรงงาน (MENU > Restore Defaults) 

  การเรียกคืนค่าที่ตั้งไว้โดยเฉพาะหน้า (Specific page) 
ผู้ใช้สามารถเรียกคืนค่าที่ตั้งไว้โดยเฉพาะในหน้าแผนที่ หน้าเข็มทิศ และหน้าข้อมูลการเดินทาง 

โดยมีขั้นตอนดังนี ้
1) เปิดหน้าที่ตอ้งการเรียกคืนการต้ังค่า 
2) กดปุ่ม MENU > ใช้ค่าโรงงาน (MENU > Restore Defaults) 

7. ข้อมูลการรับสัญญาณดาวเทียม 
หน้าดาวเทียม (Satellite Page) เป็นหน้าที่แสดงข้อมูลการรับสัญญาณดาวเทียมหลังจากที่เปิดการ

ท างานเครื่อง (รูปที่ 4) MAHID
OL
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รูปที่ 4 หน้าดาวเทียม 
 

รายละเอียดต่าง ๆ ของข้อมูลที่แสดงในหน้าดาวเทียม มีดังนี้ 
1. ค่าพิกัดต าแหน่งปัจจุบัน เป็นค่าพิกัดต าแหน่งที่ค านวณได้หลังจากที่สามารถรับสัญญาณดาวเทียมได้

อย่างน้อย 4 ดวง โดยแสดงในรูปแบบของค่าพิกัดตามที่ผู้ใช้ก าหนดในการตั้งค่ารูปแบบระบบพิกัด (ตั้งค่า > 
รูปแบบต าแหน่ง (Setup > Position Format)) ทั้งนี้ ค่าที่แสดงจะมีการเปลี่ยนแปลงได้ตลอดเวลาขึ้นอยู่กับ
สภาพการรับสัญญาณดาวเทียมของเครื่อง 

2. ระบบดาวเทียมและระดับความถูกต้องเชิงต าแหน่ง เป็นข้อมูลที่แสดงระบบการรับสัญญาณ
ดาวเทียมของเครื่อง ซึ่งก าหนดได้จากการตั้งค่าระบบ (ตั้งค่า > ระบบ > ระบบดาวเทียม (Setup > System 
> Satellite System)) และมีการแสดงข้อมูลระดับความถูกต้องทางราบของเครื่อง ซึ่งเปลี่ยนแปลงได้
ตลอดเวลาขึ้นอยู่กับสภาพการรับสัญญาณดาวเทียมของเครื่อง จากรูป 4 ระดับความถูกต้องเชิงต าแหน่งที่
ค านวณได ้คือ 3 เมตร12 

3. ค่าความสูง เป็นค่าความสูงที่ค านวณได้จากระบบดาวเทียมน าร่อง (GNSS based elevation) ซึ่ง
เป็นค่าความสูงทรงรี (Ellipsoidal height) บนมูลฐาน WGS84 ที่เปลี่ยนแปลงได้ตลอดเวลาขึ้นอยู่กับสภาพ
การรับสัญญาณดาวเทียมของเครื่อง จากรูป 4 ค่าที่ค านวณ คือ 9 เมตร อย่างไรก็ตาม ค่าความสูงที่ค านวณได้
น้ี จะมีค่าความคลาดเคลื่อนค่อนข้างมาก และเป็นค่าความสูงที่ใช้ระบบอ้างอิงที่แตกต่างจากค่าความสูงใน
แผนที่ภูมิประเทศ13 ดังนั้น เมื่อเปรียบเทียบค่าความสูงที่อ่านได้จากหน้าดาวเทียมกับค่าความสูงที่อ่านได้จาก
แผนที่ภูมิประเทศ หรือค่าความสูงจากแหล่งข้อมูลที่มีความถูกต้องสูง (Highly reliable sources) จะพบว่ามี

                                           
12

 โดยทั่วไป เครื่องรับสัญญาณระบบดาวเทียมน าร่องแบบมือถือ มีระดับความถูกต้องของต าแหน่งทางราบ (Horizontal accuracy) < 15 เมตร 

ที่ระดับ 95% และมีระดับความถูกต้องของต าแหน่งทางดิ่ง (Vertical accuracy) เป็น 2 เท่าของระดับความถูกต้องของต าแหน่งทางราบ ซึ่งการ
ใช้งาน เครื่องรับสัญญาณระบบดาวเทียมน าร่องแบบมือถือ เช่น GPSMAP 64s จะมีระดับความถูกต้องของต าแหน่งทางราบไม่เกิน 3 เมตร 
13

 ค่าความสูงในแผนที่ภูมิประเทศอ้างอิงจากระดับทะเลปานกลาง (Mean Sea Level: MSL) 
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ความแตกต่างกันค่อนข้างมาก ด้วยเหตุนี้ การน าค่าความสูงที่อ่านได้จากหน้าดาวเทียมไปใช้งาน ต้องค านึงถึง
ระดับความถูกต้องของข้อมูลและระดับความเหมาะสมของการน าไปใช้งาน 

4. เส้นแนวขอบฟ้า เป็นเส้นที่แสดงแนวเส้นขอบฟ้า ณ ต าแหน่งของผู้ใช้งานเครื่อง เพื่ออ้างอิงถึง
ต าแหน่งดาวเทียมที่ก าลังโคจรอยู่ในขณะที่ใช้งานเครื่อง 

5. เส้นแนว 45 องศา จากเส้นขอบฟ้า เป็นเส้นที่แสดง แนวเส้น 45 องศา จากเส้นขอบฟ้า ณ ต าแหน่ง
ของผู้ใช้งานเครื่อง เพื่ออ้างอิงถึงต าแหน่งดาวเทียมที่ก าลังโคจรอยู่ในขณะที่ใช้งานเครื่อง 

6. หมายเลขดาวเทียมและสภาพการรับสัญญาณ เป็นข้อมูลหมายเลขของดาวเทียมที่เครื่องก าลังรับ
สัญญาณโดยที่แท่ง (Bar) ทึบแสดงว่าเครื่องสามารถล็อกสัญญาณได้ และความสูงของแท่งบ่งบอกถึงระดับ
ความแรงของสัญญาณ (Strength) 

8. การท างานกับแผนที ่
สัญลักษณ์   ที่ปรากฏในหน้าแผนที่ (Map Page) แสดงต าแหน่ง ณ ปัจจุบัน ของเครื่อง เมื่อเครื่อง

เคลื่อนที่ สัญลักษณ์  จะเคลื่อนที่ตามไปด้วย และจะปรากฏเส้น แสดงเส้นทางที่ได้เคลื่อนที่ผ่านมา (Trail)  
รวมทั้งจะมีชื่อ Waypoint และสัญลักษณ์ต่าง ๆ ปรากฏบนแผนที่ เช่นเดียวกัน นอกจากนี้ ถ้าก าลังใช้เครื่อง
ในการน าทางไปยังจุดหมาย จะมีสัญลักษณ์แทนเส้นทาง (Route) เป็นเส้นสีม่วงแดงปรากฏบนแผนที่ ส าหรับ
การท างานกับแผนที่มีขั้นตอนดังนี้ 

1) คลิกปุ่ม PAGE เพื่อเลือก แผนที่ (Map) 
2) เลือกท างานกับแผนที่ได้ดังนี้ 

  กดปุ่ม เพื่อเลื่อนตัวชี้ต าแหน่งบนแผนที่ (Map cursor) ไปดูแผนที่ในบริเวณต่าง ๆ 

  กดปุ่ม IN หรือ OUT เพื่อซูมเข้าและซูมออกบนแผนที่ 

  เลื่อนตัวชี้ต าแหน่งบนแผนที่ไปยังต าแหน่งที่ต้องการแล้ว กดปุ่ม ENTER เพื่อแสดงข้อมูล
เกี่ยวกับต าแหน่งที่ถูกเลือก 

9. การท างานกับข้อมูล Waypoint 
Waypoint คือ ต าแหน่งต่าง ๆ ที่บันทึกและจัดเก็บไว้ในอุปกรณ์ การท างานกับข้อมูล Waypoint มี

รายละเอียดดังนี ้

9.1 การสร้าง Waypoint 
การบันทึกต าแหน่งปัจจุบันเป็น Waypoint มีขั้นตอนดังนี้ 
1) กดปุ่ม MARK 
2) ก าหนดค่าตวัเลือกของ Waypoint ตามที่ต้องการ  
3) เลือก เสร็จ (Done) 
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9.2 การสร้าง Waypoint ใหม่ด้วยค่าทิศทางและระยะทาง 
การสร้าง Waypoint ใหม่ด้วยค่าทิศทางและระยะทาง คือ การสร้าง Waypoint ใหม่ จากค่า

ทิศทางและระยะทางที่ผู้ใช้ก าหนด โดยค านวณอ้างอิงจากต าแหน่งพิกัดของ Waypoint ที่มีอยู่แล้ว ซึ่งมี
ขั้นตอนดังนี้ 

1) เปิดหน้า เมนูหลัก (Main Menu) เลือก จัดการ Waypoint (Waypoint Manager) 
2) เลือก Waypoint ที่ต้องการใช้เป็นจุดอ้างอิงส าหรับการสร้าง Waypoint จากค่าทศิทางและ

ระยะทาง โดยใช้ปุ่ม เพื่อเลื่อนไปเลือกยัง Waypoint ทีต่้องการ จากนั้นกดปุ่ม ENTER 
3) กดปุ่ม MENU เลือก Project Waypoint 
4) ระบุค่ามุม และเลือก เสร็จ (Done) 
5) ระบุหน่วยของการวัดระยะ 
6) ระบุค่าระยะทาง และเลือก เสร็จ (Done) 
7) เลือก จัดเกบ็ (Save) หรอืเลือก จัดเก็บและแก้ไข (Save and Edit) 

9.3 การหา Waypoint 
1) กดปุ่ม FIND เลือก Waypoints 
2) เลือก Waypoint ที่ต้องการ 

9.4 การแก้ไข Waypoint 
ในการแก้ไข Waypoint เครื่องจะต้องมีข้อมูล Waypoint บันทึกอยู่ในเครื่อง การแก้ไข Waypoint 

มีขั้นตอนดังนี ้
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก จัดการ Waypoint (Waypoint Manager) 
2) เลือก Waypoint ที่ต้องการแก้ไข 
3) เลือกรายการที่ต้องการแก้ไข 
4) แก้ไขข้อมลู 
5) เลือก น าทาง (Go) 

9.5 การลบ Waypoint 
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก จัดการ Waypoint (Waypoint Manager) 
2) เลือก Waypoint ที่ต้องการลบ 
3) กดปุ่ม MENU เลือก ลบ > ใช่ (Delete > Yes) 
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9.6 การเพิ่มความแม่นย าของต าแหน่ง Waypoint14 
เครื่องจะสามารถค านวณข้อมูล Waypoint ได้หลายค่า เมื่อบันทึกข้อมูล ณ ต าแหน่งนั้น ๆ ภายใน

ช่วงระยะเวลาหนึ่งอย่างต่อเนื่อง การน าข้อมูล Waypoint หลาย ๆ ค่ามาหาค่าเฉลี่ยจะช่วยเพิ่มความแม่นย า
ของต าแหน่ง Waypoint ได้ การเพิ่มความแม่นย าของต าแหน่ง Waypoint มีขั้นตอนดังนี ้

  การสร้าง Waypoint ส าหรับการเฉลี่ย 
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก การเฉลี่ย Waypoint (Waypoint Averaging) 
2) เลือก สร้าง Waypoint (Create Waypoint) 
3) เมื่อแถบสถานะระดับความเชื่อมั่น (Sample Confidence) มีค่า 100% ให้เลือก จัดเก็บ 

(Save) 

 การเฉลี่ย Waypoint เพิ่มเติม 
1) ผู้ใช้ไปอยู่ ณ ต าแหน่งของ Waypoint เดิม ที่ต้องการเฉลี่ยข้อมลูเพิ่มเติม 
2) เปิดหน้า เมนูหลัก (Main Menu) เลือก การเฉลี่ย Waypoint (Waypoint Averaging) 
3) เลือก Waypoint ที่บันทึกข้อมูล ณ ต าแหน่งนั้นในเครื่อง 
4) เลือก เริ่มตน้ (Start) 
5) เมื่อแถบสถานะระดับความเชื่อมั่นมีค่า 100% ให้เลือก จัดเก็บ (Save) 

10. การท างานกับข้อมูล Route 
เส้นทาง (Route) คือ กลุ่ม Waypoint (ปกติ มักจะมีไม่น้อยกว่า 2 Waypoint) ที่เรียงเป็นล าดับ

ต่อเนื่องกัน และใช้เป็นเส้นทางการเดินทาง เช่น เส้นทางระหว่าง กรุงเทพ – เชียงใหม่ อาจประกอบด้วย 4 
Waypoint ได้แก่ 1) Waypoint ที่กรุงเทพมหานคร 2) Waypoint ที่นครสวรรค์ 3) Waypoint ที่ตาก และ 
4) Waypoint ที่เชียงใหม่ เป็นต้น การท างานกับ Route มีรายละเอียด ดังนี ้

10.1 การสร้างเสน้ทาง 
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก วางแผนเส้นทาง > สร้างเส้นทาง > เลือกจุดเริ่มต้น 

(Route Planner > Create Route > Select First Point) 
2) เลือกประเภทของหมวดหมู่ Waypoint ซึ่งอาจจะเป็น Waypoint ที่ผู้ใช้สร้างขึ้นเอง หรือ

จัดเตรียมมาพร้อมกับเครื่อง 
3) เลือก Waypoint ที่ใช้เป็นจุดแรกในเส้นทาง 
4) เลือก ใช้ > เลือกจุดต่อไป (Use > Select Next Point) 
5) ท าขั้นตอน 2 – 4 ซ้ าจนกระทั่งก าหนดเส้นทางเสร็จสมบูรณ์ 
6) กดปุ่ม QUIT เพื่อบันทึกเส้นทาง 

                                           
14

 การเฉลี่ย Waypoint ควรเก็บข้อมูล 4 – 8 ตัวอย่าง และแต่ละตัวอย่างควรมีระยะเวลาห่างกันอย่างน้อย 90 นาที จึงจะได้ผลลัพธ์ที่ดีท่ีสุด 
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10.2 การแก้ไขชื่อเส้นทาง 
ในการแก้ไขชื่อเส้นทาง ผู้ใช้จ าเป็นต้องมีเส้นทางที่บันทึกไว้ก่อน จึงจะสามารถแก้ไขชื่อเส้นทางได้ 

การแก้ไขชื่อเส้นทางมีขั้นตอน ดังนี้ 
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก วางแผนเส้นทาง (Route Planner) 
2) เลือกเส้นทางที่ต้องการแก้ไขชื่อ 
3) เลือก เปลี่ยนช่ือ (Change Name) 
4) เปลี่ยนช่ือใหม่ตามต้องการ 
5) เลือก เสร็จ (Done) 

10.3 การแก้ไขเสน้ทาง 
ในการแก้ไขเส้นทาง ผู้ใช้จ าเป็นต้องมีเส้นทางที่บันทึกไว้ก่อน จึงจะสามารถแก้ไขเส้นทางได้ การ

แก้ไขเส้นทางมีขั้นตอน ดังนี ้
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก วางแผนเส้นทาง (Route Planner) 
2) เลือกเส้นทางที่ต้องการแก้ไข 
3) เลือก แก้ไขเส้นทาง (Edit Route) 
4) เลือก Waypoint ที่มีอยู่ในเส้นทางแล้ว หรือเลือก เลือกจุดต่อไป (Select Next Point) เพื่อ

เลือก Waypoint ที่จะเพ่ิมในเส้นทาง 
5) ในกรณีที่เลอืก Waypoint ที่มีอยู่ในเส้นทางแล้ว จะมตีัวเลือกส าหรับแก้ไขเส้นทางดังนี้ 

  เลือก ทบทวน (Review) เพื่อแสดง Waypoint บนแผนที่ 

  เลือก เลื่อนลง (Move Down) หรือ เลื่อนขึ้น (Move Up) เพื่อเปลี่ยนล าดับของ Waypoint 
บนเส้นทาง 

  เลือก แทรก (Insert) เพื่อเพิ่ม Waypoint ในเส้นทาง โดยที่ Waypoint ใหม่ จะถูกแทรก
ก่อน Waypoint ที่ก าลังแก้ไขอยู ่

  เลือก ลบ (Remove) เพื่อลบ Waypoint ออกจากเส้นทาง 

  กดปุ่ม QUIT เพื่อบันทึกเส้นทาง 

10.4 การดูเสน้ทางบนแผนที ่
ในการดูเส้นทางบนแผนที่ ผู้ใช้จ าเป็นต้องมีเส้นทางที่บันทึกไว้ก่อน จึงจะสามารถดูเส้นทางได้ การดู

เส้นทางบนแผนที่มีขั้นตอน ดังนี ้
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก วางแผนเส้นทาง (Route Planner) 
2) เลือกเส้นทางที่ต้องการดูบนแผนที่ 
3) เลือก ดูแผนที่ (View Map) 
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10.5 การลบเส้นทาง 
ในการลบเส้นทาง ผู้ใช้จ าเป็นต้องมีเส้นทางที่บันทึกไว้ก่อน จึงจะสามารถลบเส้นทางได้ การลบ

เส้นทางมีขั้นตอน ดังนี้ 
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก วางแผนเส้นทาง (Route Planner) 
2) เลือกเส้นทางที่ต้องการลบ 
3) เลือก ลบแผนที่ > ใช่ (Delete Route > Yes) 

10.6 การดูรายละเอียดของเสน้ทางที่ก าลังใช้งาน (Active Route) 
การดูรายละเอียดเกี่ยวกับ Waypoint ของเส้นทางที่ก าลังใช้งาน (ในระหว่างที่ผู้ใช้ก าลังใช้ฟังก์ชัน

การน าทางบนเส้นทาง) มีขั้นตอนดังนี ้
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก เส้นทางที่ใช้งาน (Active Route) 
2) เลือก Waypoint ในเส้นทางเพื่อดูรายละเอียดเพ่ิมเติมตามที่ต้องการ 

10.7 การย้อนกลับเส้นทาง 
การย้อนกลับเส้นทาง หมายถึง การสลับล าดับของเส้นทางใหม่ทั้งหมด โดยที่จุดเริ่มต้นของเส้นทาง

จะเป็นจุดหมายปลายทาง และจุดหมายปลายทางจะเป็นจุดเริ่มต้น เช่น เส้นทางเดิมมีล าดับจ าก 
กรุงเทพมหานคร-นครสวรรค์-ตาก-เชียงใหม่ เมื่อใช้ค าสั่งย้อนกลับเส้นทาง จะได้เส้นทางที่มีล าดับจาก 
เชียงใหม่-ตาก-นครสวรรค์-กรุงเทพมหานคร เป็นต้น 

ในการย้อนกลับเส้นทาง ผู้ใช้จ าเป็นต้องมีเส้นทางที่บันทึกไว้ก่อน จึงจะสามารถใช้ค าสั่งย้อนกลับ
เส้นทางได ้การย้อนกลับเส้นทาง มีขั้นตอน ดังนี ้

1) เปิดหน้า เมนูหลัก (Main Menu) เลือก วางแผนเส้นทาง (Route Planner) 
2) เลือกเส้นทางที่ต้องการย้อนกลับเส้นทาง 
3) เลือก เส้นทางย้อนกลับ (Reverse Route) (เมื่อเปิดดูล าดับ Waypoint ในเส้นทางตามขั้นตอน

ในหัวข้อ 10.3 การแก้ไขเส้นทาง หน้า 19 จะพบว่า Waypoint ในเส้นทางจะเรียงล าดับใหม่) 

10.8 การตั้งค่าการน าทาง (Routing settings) 
การค านวณค่าการน าทาง และตัวเลือกที่ผู้ใช้สามารถเลือกได้ในการตั้งค่าต่าง ๆ  จะแตกต่างกัน

ไปตามกิจกรรมที่ผู้ใช้เลือก15 ซึ่งอุปกรณ์จะค านวณเส้นทางที่เหมาะสมส าหรับประเภทของกิจกรรมที่ผู้ใช้
เลือก การตั้งค่าการน าทางท าได้โดยเลือก เมนูหลัก > ตั้งค่า > การน าทาง (Main Menu > Setup > 
Routing) ซึ่งในตัวอย่างที่จะอธิบายต่อไปนี้ จะแสดงตัวเลือกการตั้งค่าการน าทางโดยเลือกกิจกรรมแบบ 
Automobile Driving ซึ่งมรีายละเอียดดังนี้ 
                                           
15

 รายการกิจกรรมที่ผู้ใช้สามารถเลือกได้ ประกอบด้วย Direct Routing, Automobile Driving, Motorcycle Driving, Cycling, Tour 

Cycling, Mountain Biking, ทางเดินเท้า (Pedestrian Walking), Hiking, Mountaineering, ATV/Off Road Driving, ถามก่อน 
(Prompted) ซึ่งผู้ใช้สามารถเลือกตั้งค่าการน าทางแต่ละกิจกรรมได้ตามความเหมาะสม 
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รายการ ตัวเลือก ค าอธิบาย 
Activity Automobile Driving ก าหนดประเภทกิจกรรมแบบการขับรถยนต ์

Calculation 
Method 

Minimize Time เลือกน าทางแบบใช้ระยะเวลาที่สั้นที่สุด 
Minimize Distance เลือกน าทางแบบใช้ระยะทางที่สั้นที่สุด 

ถามก่อน 
(Prompted) 

เลือกถามผู้ใช้วา่ต้องการเลือกการน าทางแบบใด 

ล็อกบนถนน 
(Lock On Road) 

ใช ่
(Yes) 

เลือกล็อกไอคอนที่แสดงต าแหน่งของผู้ใชบ้นแผนที่เข้า
กับถนนที่ใกล้ที่สุด 

ไม่ 
(No) 

เลือกไมล่็อกไอคอนที่แสดงต าแหน่งของผู้ใช้บนแผนที่เข้า
กับถนนที่ใกล้ที่สุด 

ตั้งค่าหลีกเลี่ยง 
(Avoidance Setup) 

ตัวเลือกรายการเพื่อ
หลีกเลี่ยง 

ตัวเลือกทีส่ามารถเลือกใหห้ลีกเลี่ยงในการน าทาง ได้แก่ 
กลับรถ (U-Turns), ทางด่วน (Toll Roads), Interstate 
Highways, Major Highways, ทางลูกรัง (Unpaved 
Roads), เลนรถร่วม (Carpool Lanes), Ferries ซึ่งการ
เลือกเปิด/ปิดตัวเลือกใด ๆ สามารถท าได้โดยใช้ปุ่ม 

เพื่อเลื่อนไปเลือกตัวเลือกนั้น และกดปุ่ม 
ENTER เพื่อเลือกหรือยกเลิกการเลือก โดยตัวเลือกที่ถูก
เลือกแล้ว จะมเีครื่องหมายถูกปรากฏอยู่หน้าตัวเลือก 

Off Route 
Recalculation 

ถามก่อน 
(Prompted) 

เลือกถามผู้ใช้วา่ต้องการเลือกค านวณการน าทางใหม่
หรือไม่ ในกรณีทีผู่้ใช้เคลื่อนที่ออกจากเส้นทางที่ก าหนด 

อัตโนมัติ 
(Automatic) 

เลือกค านวณการน าทางใหม่อัตโนมัติ ในกรณีทีผู่้ใช้
เคลื่อนที่ออกจากเส้นทางที่ก าหนด 

ปิด 
(Off) 

เลือกไม่ค านวณการน าทางใหม่ 

11. การท างานกับข้อมูล Track 
รอยทาง (Track) หมายถึง เส้นทางจริงที่ผู้ใช้เดินทางผ่านขณะที่ก าลังใช้งานเครื่อง เปรียบได้กับรอยเท้า

ที่เกิดขึ้นไปตามเส้นทางเดินของผู้ใช้เครื่อง ทั้งนี้ Track log คือ ข้อมูลจุดที่ถูกจัดเก็บไว้ในเครื่องโดยอัตโนมัติ
ขณะที่ผู้ใช้ก าลังเคลื่อนที่ ข้อมูลจุดที่จัดเก็บประกอบด้วยข้อมูลเวลา ต าแหน่ง และความสูง นอกจากนี้ ถ้าผู้ใช้
ก าหนดให้มีการบันทึกข้อมูล Track และให้แสดงบนแผนที่ ข้อมูล Track นี้จะสามารถใช้ในการน าทางกลับไป
ยังเส้นทางเดิมของผู้ใช้ได้อีกด้วย 

เพื่อให้การบันทึก จัดเก็บ และใช้งาน Track เป็นไปอย่างถูกต้อง ผู้ใช้ควรมีความเข้าใจเกี่ยวกับประเภท
ของข้อมูล Track ที่จัดเก็บในเครื่อง ซึ่งแบ่งออกเป็น 3 ประเภท คือ 
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1) Track ปัจจุบัน (Current Track) คือ Track ที่จัดเก็บข้อมูลจุดของ Track ณ ขณะที่ผู้ใช้ก าลังใช้
งานเครื่องและได้เปิดให้มีการบันทึก Track logs ซึ่งผู้ใช้สามารถจัดเก็บหรือบันทึก Track ปัจจุบัน ให้เป็น
ข้อมูลประเภท Track เก็บบันทึก หรือ Track ที่จัดเก็บไว้ถาวร 

2) Track เก็บบันทึก (Saved Track) คือ Track ที่ผู้ใช้บันทึกไว้ในเครื่อง ซึ่งอาจจะเป็น Track ที่
สร้างจากการบันทึกข้อมูลจาก Track ปัจจุบัน หรือน าข้อมูล Track มาจากโปรแกรม MapSource หรือ 
BaseCamp เพื่อมาใช้งานในเครื่อง ข้อมูล Track ประเภทนี้ สามารถใช้ค าสั่ง แสดงบนแผนที่ (Show On 
Map) หรือ Copy Reverse ได ้และมักจะเป็นข้อมูล Track ที่มีการใช้งานบ่อย ๆ (Favorite Track) ในกรณีที่
ผู้ใช้ไม่มีความจ าเป็นในการใช้งาน Track ประเภทนี้ ผู้ใช้สามารถจัดเก็บ Track ประเภทนี้ ให้เป็น Track ที่
จัดเก็บไว้ถาวร 

3) Track ที่จัดเก็บไว้ถาวร (Archived Track) คือ Track ถูกจัดเก็บไว้ในพื้นที่จัดเก็บข้อมูลถาวรของ
เครื่อง (Archive) โดยมีวัตถุประสงค์ของการจัดเก็บ Track ประเภทนี้ คือ 1) เพื่อใช้จัดเก็บข้อมูลที่ผู้ใช้ไม่ได้ใช้
งานบ่อย ๆ และ 2) เพื่อใช้จัดเก็บข้อมูลจาก Track ปัจจุบัน โดยการย้ายข้อมูล Track ปัจจุบัน ไปจัดเก็บยัง
พื้นที่จัดเก็บข้อมูลถาวรแบบอัตโนมัติ เพ่ือท าให้การจัดเก็บข้อมูล Track ปัจจุบัน ในหน่วยความจ าด าเนินไปได้
อย่างต่อเนื่องโดยที่ไม่มีการบันทึกข้อมูลทับกับข้อมูลเดิมของ Track ปัจจุบัน (เครื่องสามารถจัดเก็บข้อมูล 
Track ปัจจุบัน ได้ไม่เกิน 10,000 จุดต่อ Track ดังนัน้ เมื่อจ านวนข้อมูลจุดใน Track ปัจจุบัน ใกล้ถึง 10,000 
จุด เครื่องจะสร้าง Track ที่จัดเก็บไว้ถาวร โดยอัตโนมัติ และย้ายข้อมูลจาก Track ปัจจุบัน ไปยัง Track ที่
จัดเก็บไว้ถาวร ที่สร้างขึ้น) ถ้าเครื่องมีข้อมูล Track ที่จัดเก็บไว้ถาวร เกินกว่า 20 Track ข้อมูล Track ที่เก่า
ที่สุดจะถูกลบออกจากเครื่องโดยอัตโนมัติ (เครื่องสามารถจัดเก็บข้อมูล Track ที่จัดเก็บไว้ถาวร ได้ไม่เกิน 20 
Track) ทั้งนี้ ข้อมูล Track ประเภทนี้ จะไม่สามารถใช้ค าสั่ง แสดงบนแผนที่ (Show On Map) ได้ 

การท างานกับข้อมูล Track มีรายละเอียดดังนี ้

11.1 การบันทึก Track logs 
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก ตั้งค่า > Tracks > Track log (Setup > Tracks > 

Track Log) 
2) เลือก บันทึก ไม่ต้องแสดง (Record, Do Not Show) ถ้าผู้ใช้ต้องการบันทึก Track แต่ไม่

ต้องการแสดง Track ที่บันทึกบนแผนที่ หรือผู้ใช้สามารถเลือก บันทึก แสดงบนแผนที่ (Record, Show On 
Map) ถ้าผู้ใช้ต้องการบันทึก Track และต้องการแสดง Track ที่บันทึกไว้บนแผนที่ 

3) เลือก วิธีการบันทึก (Record Method) ซึ่งมีตัวเลือกส าหรับบันทึก Track logs ดังนี ้

  เลือก อัตโนมัติ (Auto) เพื่อบันทึก Tracks แบบอัตโนมัติตามความเหมาะสมกับอัตราการ
เคลื่อนที่ของผู้ใช้ 

  เลือก ระยะทาง (Distance) เพื่อบันทึก Tracks ตามระยะทางที่ผู้ใช้ก าหนด เช่น ผู้ใช้
สามารถก าหนดให้บันทึก Track ทุก ๆ ระยะ 1 เมตร หรือ ทุก ๆ ระยะ 5 เมตร เป็นต้น 
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  เลือก เวลา (Time) เพื่อบันทึก Tracks ตามระยะเวลาที่ผู้ใช้ก าหนด เช่น ผู้ใช้สามารถ
ก าหนดให้บันทึก Track ทุก ๆ 1 นาที หรือ ทุก ๆ 5 นาที เป็นต้น 

4) เลือก ช่วง (Record Interval) หรือความถี่ในการบันทึกข้อมูล16 

  ถ้าเลือก วิธีการบันทึก (Record Method) แบบ อัตโนมัติ (Auto) ผู้ใช้ต้องก าหนดความถี่
ของช่วงที่ต้องการบันทึกข้อมูล คือ บ่อยที่สุด (Most Often), บ่อยขึ้น (More Often), ปกติ (Normal), น้อย 
(Less Often), หรือ ไม่บ่อย (Least Often) 

  ถ้าเลือก วิธีการบันทึก (Record Method) แบบ เวลา (Time) ผู้ใช้ต้องก าหนดความถี่ของ
ระยะเวลาที่ต้องการบันทึกข้อมูล จากนั้นเลือก เสร็จ (Done) 

  ถ้าเลือก วิธีการบันทึก (Record Method) แบบ ระยะทาง (Distance) ผู้ใช้ต้องก าหนด
ความถี่ของระยะทางที่ต้องการบันทึกข้อมูล จากนั้นเลือก เสร็จ (Done) 

ในขณะที่ผู้ใช้เคลื่อนทีไ่ปพร้อมกับการเปิดการใช้งานอุปกรณ์ไว้ Track log จะถูกสร้างขึ้นอัตโนมัต ิ

11.2 การบันทึก Track ปัจจุบัน 
Track ที่ก าลังบันทึกข้อมูลในขณะที่ผู้ใช้ก าลังใช้งานอุปกรณ์ เรียกว่า Track ปัจจุบัน (Current 

Track) การบันทึกข้อมูล Track ปัจจุบัน มีขั้นตอนดังนี้ 
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก จัดการ Track > Track ปัจจุบัน (Track Manager > 

Current Track) 
2) เลือก Track ปัจจุบันที่ต้องการบันทึก ซึ่งมีตัวเลือกดังนี ้

  เลือก จัดเก็บ Track (Save Track) เพื่อบันทึก Track ปัจจุบัน ทั้งหมด 

  เลือก จัดเก็บเป็นส่วน (Save Portion) เพื่อบันทึกข้อมูล Track ปัจจุบัน เพียงบางส่วน โดย
ผู้ใช้ต้องระบจุุดเริ่มต้นและจุดสิ้นของ Track ที่ต้องการบันทึก 

3) ก าหนดชื่อ Track ตามที่ผู้ใช้ต้องการ 
4) เลือก เสร็จ (Done) 
5) เมื่อเครื่องจัดเก็บข้อมูลเสร็จแล้ว ผู้ใช้สามารถเลือก ใช่ (Yes) เพื่อลบข้อมูล Track ปัจจุบันที่ได้มี

การบันทึกข้อมูลไว้แล้วออกจาก Track ปัจจุบัน หรือเลือก ไม่ (No) เพื่อเก็บข้อมูล Track ปัจจุบันไว้คงเดิม 
ข้อมูล Track ปัจจุบันที่ถูกบันทึกไว้ จะเป็นข้อมูล Track ประเภท Track เก็บบันทึก (Saved 

Track) 

11.3 การเรียกดูข้อมูล Track 
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก จัดการ Track (Track Manager) 

                                           
16

 การบันทึกข้อมูลที่มีความถี่มาก จะท าให้ Track มีรายละเอียดมากขึ้น แต่ก็จะท าให้ปริมาณข้อมูลเพิ่มมากขึ้นเช่นเดียวกัน และเนื้อที่จัดเก็บ

ข้อมูลในหน่วยความจ าของเครื่องเต็มเร็วขึ้น 
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2) เลือก Track ที่ต้องการดูข้อมูล 
3) เลือก ดูแผนที่ (View Map) 
4) กดปุ่ม MENU เลือก ทบทวน Track (Review Track) เพื่อแสดงข้อมูลเกี่ยวกับ Track 

11.4 การดผูังความสูงของ Track 
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก จัดการ Track (Track Manager) 
2) เลือก Track ที่ต้องการดูผังความสูง 
3) เลือก Profile ผังความสูง (Elevation Plot) ผู้ใช้สามารถกดปุ่ม IN หรือ OUT เพื่อซูมเข้า/ออก 

หรือกดปุ่ม เพื่อเลื่อนดูรายละเอียดของผังความสูง 

11.5 การจัดเก็บ Track ที่ถูกบันทึกไว้แลว้แบบถาวร 
ผู้ใช้สามารถจัดเก็บ Track แบบถาวร เพื่อประหยัดเนื้อทีห่น่วยความจ าของเครื่องได้ดังนี ้
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก จัดการ Track (Track Manager) 
2) เลือก Track ที่ถูกบันทึกไว้แล้ว 
3) เลือก จัดเก็บถาวร (Archive) 

11.6 การลบ Track ปัจจุบนั 
เปิดหน้า เมนูหลัก (Main Menu) เลือก ตั้งค่า > ตั้งค่าใหม่ > ลบ Track ปัจจุบัน > ใช่ (Setup > 

Reset > Clear Current Track > Yes) ข้อมูล Track ปัจจุบัน ที่ถูกบันทึกไว้ในเครื่องจะถูกลบออกทั้งหมด 
ท าให้ประหยัดเนื้อที่หน่วยความจ าของเครื่อง 

11.7 การลบ Track ที่จัดเก็บแล้ว 
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก จัดการ Track (Track Manager) 
2) เลือก Track ที่ต้องการลบ 
3) เลือก ลบ > ใช่ (Delete > Yes) 

12. การน าทาง (Navigating to a destination/ Routing) 
ผู้ใช้สามารถใช้ Waypoint, Track, Route, Geocache17, ค่าพิกัด (Coordinates), หรือข้อมูลสถานที่

ต่าง ๆ  (Point of Interest: POI) ที่จัดเก็บอยู่ในเครื่องเพื่อการน าทาง โดยใช้แผนที่หรือเข็มทิศในการน าทาง
ไปยังจุดหมายปลายทาง ซึ่งมีรายละเอียดดังนี ้

12.1 การน าทางจาก Waypoint 
1) กดปุ่ม FIND เลือก Waypoints (Waypoints) 

                                           
17

 Geocache หรือ ภูมิสมบัติ คือ กิจกรรมสันทนาการที่ใช้เครื่องรับสัญญาณระบบดาวเทียมน าร่องในกิจกรรมซ่อน-หาสิ่งของที่ใส่ไว้ในหีบหรือ

ภาชนะ 
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2) เลือก Waypoint ที่จะใชเ้ป็นจุดหมายปลายทางที่ต้องการไป 
3) เลือก น าทาง (Go) (หน้าแผนที่จะเปิดขึ้นพร้อมเส้นทางที่แสดงด้วยเส้นสีม่วง ซึ่งเป็นค่าโดย

ปริยายของเครื่อง) 
4) น าทางไปยังจุดหมายโดยใช้แผนที่หรือเข็มทิศ 

12.2 การน าทางจาก Track 
ก่อนที่ผู้ใช้จะสามารถน าทางจาก Track เครื่องต้องมีข้อมูล Track ที่จัดเก็บไว้ในเครื่องแล้ว 
1) กดปุ่ม FIND เลือก Tracks (Tracks) 
2) เลือก Track ที่จะใช้เป็นเส้นทางส าหรับการน าทาง 
3) เลือก น าทาง (TraBack) (หน้าแผนที่จะเปิดขึ้นพร้อมเส้นทางที่แสดงด้วยเส้นสีม่วง ซึ่งเป็นค่าโดย

ปริยายของเครื่อง) 
4) น าทางไปยังจุดหมายโดยใช้แผนที่หรือเข็มทิศ 

12.3 การน าทางจาก Route 
ก่อนที่ผู้ใช้จะสามารถน าทางจาก Route เครื่องต้องมีข้อมูล Track ที่จัดเก็บไว้ในเครื่องแล้ว 
1) กดปุ่ม FIND เลือก เส้นทาง (Routes) 
2) เลือก Route ที่จะใช้เป็นเส้นทางส าหรับการน าทาง 
3) เลือก น าทาง (Go) (หน้าแผนที่จะเปิดขึ้นพร้อมเส้นทางที่แสดงด้วยเส้นสีม่วง ซึ่งเป็นค่าโดย

ปริยายของเครื่อง) 
4) น าทางไปยังจุดหมายโดยใช้แผนที่หรือเข็มทิศ 

12.4 การน าทางจากคา่พิกัด 
1) กดปุ่ม FIND เลือก ค่าพิกัด (Coordinates) 
2) ระบุค่าพิกัดที่จะใช้เป็นจุดหมายปลายทางที่ต้องการไป 
3) เลือก น าทาง (Go) (หน้าแผนที่จะเปิดขึ้นพร้อมเส้นทางที่แสดงด้วยเส้นสีม่วง ซึ่งเป็นค่าโดย

ปริยายของเครื่อง) 
4) น าทางไปยังจุดหมายโดยใช้แผนที่หรือเข็มทิศ 

12.5 การน าทางจากสถานที่ (Point of Interest: POI) 
1) กดปุ่ม FIND เลือก POIs ทั้งหมด (All POIs) 
2) เลือกสถานที่ที่จะใช้เป็นจุดหมายปลายทางที่ต้องการไป 
3) เลือก น าทาง (Go) (หน้าแผนที่จะเปิดขึ้นพร้อมเส้นทางที่แสดงด้วยเส้นสีม่วง ซึ่งเป็นค่าโดย

ปริยายของเครื่อง) 
4) น าทางไปยังจุดหมายโดยใช้แผนที่หรือเข็มทิศ 
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12.6 การหยุดการท างาน 
ในระหว่างที่ก าลังใช้เครื่องส าหรับการน าทาง และผู้ใช้ต้องการหยุดหรือยกเลิกการน าทาง 

สามารถท าได้โดย กดปุ่ม FIND เลือก หยุดน าทาง (Stop Navigation) 

13. การค านวณพื้นที ่
1) เปิดหน้า เมนูหลัก (Main Menu) เลือก การค านวณพื้นที่ > เริ่มต้น (Area Calculation > Start) 
2) ผู้ใช้ต้องเดินรอบเส้นรอบรูปของพื้นที่ที่ต้องการค านวณ 
3) เลือก ค านวณ (Calculate) เมื่อเดินจนบรรจบเส้นรอบรูปของพื้นที่ 

14. การใช้งานเข็มทิศอิเล็กทรอนิกส์18 
GPSMAP® 64s มีเข็มทิศอิเล็กทรอนิกส์แบบ 3 แกน ซึ่งสามารถใช้เพื่อน าทางไปยังจุดหมายได ้

14.1 การปรับตั้งเข็มทิศอิเลก็ทรอนิกส์ (Calibrating the Compass) 
ในการปรับตั้งเข็มทิศอิเล็กทรอนิกส์ ผู้ใช้ควรด าเนินการปรับต้ังขณะที่อยูภ่ายนอกอาคาร และควรให้

เครื่องอยู่ห่างไกลจากวัตถุที่รบกวนสนามแม่เหล็ก เช่น รถยนต ์อาคาร หรือสายไฟที่อยู่เหนือศีรษะ 
ผู้ใช้ควรปรับตั้งเข็มทิศหลังจากมีการย้ายต าแหน่งออกไปจากต าแหน่งเดิมเป็นระยะทางไกล ๆ หรือ

พบว่ามีการเปลี่ยนแปลงของอุณหภูมิขณะที่ก าลังใช้เครื่อง หรือมีการเปลี่ยนแบตเตอรี่ การปรับตั้งเข็มทิศ
อิเล็กทรอนิกส์มีขั้นตอนดังนี ้

1) เปิดหน้า เข็มทิศ (Compass) 
2) กดปุ่ม MENU เลือก ปรับต้ังเข็มทิศ > เริ่มต้น (Calibrate Compass > Start) 
3) ปฏิบัติตามขั้นตอนบนหน้าจอ 

14.2 การน าทางด้วยลูกศรชี้ทิศทาง (Bearing19 pointer) 
ในการน าทางไปยังจุดหมายปลายทาง (Navigation) ด้วยลูกศรชี้ทิศทาง สัญลักษณ์    จะชี้ไปยัง

จุดหมายตลอดเวลา (รูปที่ 5) ถ้าลูกศรชี้ทิศทาง ชี้ตรงไปในทิศทางเดียวกับที่ผู้ใช้ก าลังมุ่งหน้าไป แสดงว่าผู้ใช้
ก าลังเคลื่อนที่ไปในทิศทางที่ไปยังจุดหมาย แต่ถ้าลูกศรชี้ทิศทางชี้ไปยังทิศทางอื่น ๆ แสดงว่าผู้ใช้ไม่ได้ก าลัง
เคลื่อนที่ไปยังทิศทางเป้าหมาย ทั้งนี้ การปรับทิศทางการเดินทางเพื่อให้ผู้ใช้เดินทางไปยังจุดหมายที่ก าหนดไว้ 
ผู้ใช้ต้องหมุนปรับเปลี่ยนทิศทางจนกระทั่งสัญลักษณ์    ชี้ไปยังขีด (Mark) ที่อยู่ด้านบนของหน้าปัดเข็มทิศ 

                                           
18

 เมื่อเครื่องอยู่ในโหมดหรือโพรไฟล์รถยนต์ (Automotive profile) หน้าเข็มทิศจะแสดงทิศทางการเคลื่อนที่โดยอ้างอิงกับทิศทางการเคลื่อนที่

ไปข้างหน้าของเครื่อง (GPS heading) มิใช่อ้างอิงกับทิศเหนือแม่เหล็ก (Compass heading) 
19

 แบริง หรือ มุมแบริง คือ มุมที่วัดจากทิศเหนืออ้างอิงจากวัตถุหนึ่งไปยังอีกวัตถุหนึ่ง ในกรณีการน าทางด้วยเครื่องรับสัญญาณระบบ

ดาวเทียมน าร่อง แบริง หมายถึง ทิศทางที่วัดจากต าแหน่ง ณ ปัจจุบัน ของเครื่องรับสัญญาณระบบดาวเทียมน าร่องไปยังต าแหน่งของ
จุดหมายปลายทางที่ผู้ใช้ก าหนด 
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ฟังก์ชันน้ีจะมีประโยชน์ในกรณีที่ต้องเดินทางหลบหลีกสิ่งกีดขวางเส้นทางต่าง ๆ เช่น หนองน้ า หรือ พื้นที่ส่วน
บุคคล เป็นต้น   

 
รูปที่ 5 ลูกศรชีท้ิศทางส าหรับการน าทางไปยังจุดหมายปลายทาง 

(ที่มา: Garmin Ltd. 2006. eTrex Vista Cx Owner’s Manual. p. 53) 
 
การใช้เครื่องรับสัญญาณระบบดาวเทียมน าร่อง เพื่อน าทางไปยังจุดหมายปลายทางที่ผู้ใช้ต้องการ

ด้วยลูกศรชี้ทิศทาง มีขั้นตอนดังนี ้
1) เริ่มการน าทางไปยังจุดหมาย (ดูหัวข้อ 12. การน าทาง (Navigating to a destination/ 

Routing) หน้า 24) 
2) เปิดหน้า เข็มทิศ (Compass) 
3) หมุนปรับทิศทางจนสัญลักษณ์   ชี้ไปที่ด้านบนของเข็มทิศ และให้เคลื่อนที่มุ่งหน้าไปยังทิศทาง

นั้นเพ่ือไปยังจุดหมาย 

14.3 การน าทางด้วยลูกศรชี้เส้นทาง20 (Course pointer) 
ลูกศรชี้เส้นทาง  แสดงความสัมพันธ์ระหว่างทิศทางของผู้ใช้ขณะที่ก าลังเดินทางเทียบกับเส้นทาง

ที่ก าหนดไว้เพื่อไปยังจุดหมายปลายทาง (Course line) ซึ่งค านวณจากต าแหน่งของจุดเริ่มต้นของการน าทาง
ไปยังต าแหน่งของจุดหมายปลายทาง เมื่อผู้ใช้เดินทางออกนอกเส้นทาง ตัวบ่งชี้การเบี่ยงเบนจากเส้นทาง 
(Course Deviation Indicator: CDI)  จะบ่งบอกว่าทิศทางที่ผู้ใช้ก าลังเคลื่อนที่ได้เบี่ยงเบนออกไปทางขวา
หรือทางซ้ายของเส้นทางที่ก าหนด (Right or left drift) ทั้งนี้ ระยะทางที่เบี่ยงเบนออกนอกเส้นทางสามารถ
อ่านได้จากมาตราส่วน  ที่ใช้แสดงค่าระยะทางระหว่างจุดของเส้นจุดประ  จากตัวบ่งชี้การเบี่ยงเบนจาก
เส้นทาง (รูปที่ 6) 

 

                                           
20

 ผู้ใช้ต้องตั้งค่ารูปแบบทิศทางที่มุ่งหน้าไปเป็นแบบ Course (CDI) ก่อนการใช้ค าสั่งการน าทางด้วยลูกศรชี้เส้นทาง 
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. 
รูปที่ 6 ลูกศรชีเ้ส้นทางส าหรับการน าทางไปยังจุดหมายปลายทาง 

(ที่มา: Garmin Ltd. 2014. GPSMAP® 64 Owner’s Manual. p.4) 
 

ยกตัวอย่างเช่น ตัวบ่งช้ีการเบ่ียงเบนจากเส้นทาง มีระยะห่างออกจากเส้นทางที่ก าหนดไปทางขวา 1 
จุด และมาตราส่วนที่แสดงมีค่า 0.25 ไมล์ หมายความว่า ผู้ใช้เดินทางออกนอกเส้นทางไปทางขวาเป็น
ระยะทางประมาณ 0.25 ไมล์ เป็นต้น (รูปที่ 7) ลูกศรชี้ทิศทางมีความเหมาะสมส าหรับการน าทางบนพื้นน้ า 
หรือสถานที่ที่ไม่มีสิ่งกีดขวางในเส้นทาง 

 

 
รูปที่ 7 ลูกศรชีท้ิศทางส าหรับการน าทางไปยังจุดหมายปลายทาง 

(ที่มา: Garmin Ltd. 2006. eTrex Vista Cx Owner’s Manual. p. 54) 
 
การใช้เครื่องรับสัญญาณระบบดาวเทียมน าร่อง เพื่อน าทางไปยังจุดหมายปลายทางที่ผู้ใช้ต้องการ

ด้วยลูกศรชี้เส้นทาง มีขั้นตอนดังนี ้
1) เริ่มการน าทางไปยังจุดหมาย (ดูหัวข้อ 12. การน าทาง (Navigating to a destination/ 

Routing) หน้า 24) 
2) เปิดหน้า เข็มทิศ (Compass) 
3) กดปุ่ม MENU เลือก ตั้งค่าทิศทางที่มุ่งไป > ไปยัง line/ต าแหน่งนี้ > เส้นทาง (Setup Heading 

> Go To Line (Pointer) > Course (CDI)) 
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4) หมุนปรับทิศทางจนกระทั่งลูกศรชี้เส้นทาง และตัวบ่งชี้การเบี่ยงเบนจากเส้นทาง แสดงทิศทาง
การเคลื่อนที่ที่ถูกต้องไปยังจุดหมายปลายทาง 

15. มาตรระดับความสูง (Altimeter) 
ในเครื่อง GPSMAP® 64s จะมีอุปกรณ์รับรู้ความดันบรรยากาศ (Barometric sensor) ท าให้สามารถ

ค านวณความสูงจากการเปลี่ยนแปลงความดันบรรยากาศ (Barometric altitude) ได้ (เมื่อระดับความสูง
เพิ่มขึ้น ความดันบรรยากาศจะลดลง) โดยค่าความสูงที่ได้มาจากอุปกรณ์รับรู้ความดันบรรยากาศจะใช้ส าหรับ
แสดงในผังความสูง หรือข้อมูลการเดินทาง ยกเว้นหน้าดาวเทียม (Satellite Page) ที่จะใช้ค่าความสูงที่
ค านวณได้จากการรับสัญญาณดาวเทียม 

15.1 การตั้งค่าการท างานของมาตรระดับความสูง 
การตั้งค่าการท างานของมาตรระดับความสูง ท าได้โดยเปิดหน้า เมนูหลัก (Main Menu) เลือก ตั้ง

ค่า > เครื่องวัดความสูง (Setup > Altimeter) ซึ่งมีตัวเลือกส าหรับการตั้งค่าต่าง ๆ ดังนี้ 
 

รายการ ตัวเลือก ค าอธิบาย 

ปรับต้ังอัตโนมัต ิ
(Auto Calibration) 

เปิดใช้งาน 
(On) 

เปิดให้เครื่องปรับตั้งมาตรระดับความสูงแบบอัตโนมัติ
เมื่อเปิดเครื่อง โดยใช้ค่าความสูงที่ค านวณได้จากการรับ
สัญญาณดาวเทียม21 

ปิด 
(Off) 

ปิดการปรับต้ังมาตรระดับความสูงแบบอัตโนมัต ิ

โหมดวัดความกด
อากาศ 

(Barometer Mode) 

ระดับความสูงที่แปรปรวน 
(Variable Elevation) 

เลือกให้ค านวณความเปลี่ยนแปลงของความสูงขณะที่
ผู้ใช้เคลื่อนที ่

ระดับความสูงคงที่ 
(Fixed Elevation) 

เลือกใหต้รวจวัดความดันบรรยากาศที่เกิดจากการ
เปลี่ยนแปลงของสภาพลมฟ้าอากาศ โดยผู้ใช้ต้องไม่มีการ
เคลื่อนที่ (อยู่คงที่) ณ ต าแหน่งที่ทราบค่าระดับความสูง22 

Trending ของความ
กดอากาศ 
(Pressure 
Trending) 

จัดเก็บเมื่อเปิดเครื่อง 
(Save When Power 

On) 

เลือกให้เครื่องบันทึกค่าความดันบรรยากาศเมื่อเปิด
เครื่อง 

จัดเก็บ 
(Save Always) 

เลือกให้เครื่องบันทึกค่าความดันบรรยากาศทุก ๆ 15 
นาที แม้ในขณะที่ปิดเครื่อง 

                                           
21

 ดูรายละเอียดเพิ่มเติมในหัวข้อ “15.2 การสอบเทียบมาตรระดับความสูง” 
22

 เนื่องจากความสูงคงที่ การเปลี่ยนแปลงค่าความดันบรรยากาศจึงเกิดจากการเปลี่ยนแปลงของสภาพลมฟ้าอากาศ 
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รายการ ตัวเลือก ค าอธิบาย 

ประเภทแผนภูมิ 
(Plot Type) 

ความสูง / เวลา 
(Elevation / Time) 

เลือกบันทึกข้อมูลการเปลี่ยนแปลงค่าความสูงตาม
ระยะเวลา 

ความสูง / ระยะทาง 
(Elevation / Distance) 

เลือกบันทึกข้อมูลการเปลี่ยนแปลงค่าความสูงตาม
ระยะทาง 

หน่วยวัดความกดอากาศ 
(Barometric 
Pressure23) 

เลือกบันทึกข้อมูลการเปลี่ยนแปลงค่าความดัน
บรรยากาศที่ปรับแกแ้ล้วตามระยะเวลา 

ความกดอากาศล้อมรอบ 
(Ambient Pressure24) 

เลือกบันทึกข้อมูลการเปลี่ยนแปลงค่าความดัน
บรรยากาศล้อมรอบตามระยะเวลา 

ปรับต้ังเครื่องวัด
ความสูง (Calibrate 

Altimeter) 
เลือกวิธีการปรับตั้ง 

เลือกวิธีการสอบเทียบมาตรระดับความสูง โดยที่ผู้ใช้เป็น
ผู้ก าหนดค่าในการสอบเทียบเอง 

15.2 การสอบเทียบมาตรระดับความสูง 
ก่อนการใช้งานอุปกรณ์รับรู้ความดันบรรยากาศ จ าเป็นต้องมีการสอบเทียบ (Calibration) และเมื่อ

มีการสอบเทียบอย่างถูกต้องแล้ว จะให้ค่าความสูงที่อ่านได้มีระดับความถูกต้องอยู่ในระดับ 3 เมตร อย่างไรก็
ตาม เนื่องจากความดันบรรยากาศจะแปรผันตามสภาพลมฟ้าอากาศและสถานที่ ดังนั้น การใช้งานฟังก์ชัน
มาตรวัดความสูงจากความดันบรรยากาศจ าเป็นต้องมีการสอบเทียบบ่อย ๆ โดยเฉพาะเมื่อพบการ
เปลี่ยนแปลงของสภาพอากาศค่อนข้างมาก หรือมีการเปลี่ยนสถานที่ใช้งานเครื่อง 

การสอบเทียบมาตรวัดความสูงของเครื่องก่อนการใช้งาน เป็นการก าหนดระดับความสูงหรือความ
ดันบรรยากาศของเครื่องเริ่มแรก เพื่อที่จะให้อุปกรณ์รับรู้ความดันบรรยากาศ วัดความดันบรรยากาศที่
เปลี่ยนแปลงไป และน าไปค านวณเป็นค่าความความสูง 

การสอบเทียบสามารถท าได้ 2 ลักษณะ คือ 

  การสอบเทียบจากค่าระดับความสูงที่ทราบค่า (Known elevation) สามารถใช้ข้อมูลจาก 2 
แหล่ง คือ 

o  ค่าระดับความสูงที่ผู้ใช้ก าหนดเอง (User defined value) เป็นการก าหนดค่าความสูง ณ 
ต าแหน่งปัจจุบันของผู้ใช้ให้กับเครื่องโดยผู้ใช้เอง ค่านี้อาจจะเป็นค่าอ่านได้จากแผนที่ภูมิประเทศ หรือค่าจาก
หมุดควบคุมทางดิ่งที่มีความถูกต้องสูง และควรเป็นค่าที่อ้างอิงกับระดับทะเลปานกลาง (Mean Sea Level: 
MSL) เพื่อที่จะสามารถน าไปใช้งานกับแผนที่ภูมิประเทศได้โดยตรง 

                                           
23

 Barometric Pressure คือ ค่าความดันบรรยากาศที่ปรับแก้กับค่าสอบเทียบแล้ว (Calibrated pressure) 
24

 Ambient Pressure คือ ค่าความดันบรรยากาศที่อ่านได้จากอุปกรณ์รับรู้โดยตรง (Uncalibrated pressure) ณ ต าแหน่งของเครื่อง 
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o  ค่าระดับความสูง ณ ต าแหน่งปัจจุบันของเครื่อง (GNSS based elevation value) 25 เป็น
ค่าความสูงที่ค านวณได้จากเครื่อง อย่างไรก็ตาม การสอบเทียบโดยใช้ค่าระดับความสูงจากเครื่อง ท าให้ค่า
ความสูงที่อ่านได้ เป็นค่าความสูงที่เกิดจากการเปลี่ยนแปลงความดันบรรยากาศเปรียบเทียบกับค่าความความ
สูงทรงรี ณ ต าแหน่งที่มีการสอบเทียบ ท าให้ไม่สามารถน าไปใช้งานกับแผนที่ภูมิประเทศได้โดยตรง แต่จะ
สามารถใช้แสดงการเปลี่ยนแปลงระดับความสูงระหว่างที่ใช้งานเครื่องได้ (Gain and loss of elevation) 
ทั้งนี้ การสอบเทียบประเภทนี้ จะมีประโยชน์ในกรณีที่ผู้ใช้ไม่ทราบค่าความสูง หรือไม่ทราบค่าความดัน
บรรยากาศ 

  การสอบเทียบจากค่าความดันบรรยากาศที่ทราบค่า (Known barometric pressure) เป็นการ
ก าหนดค่าความดันบรรยากาศที่ทราบค่า ณ ต าแหน่งปัจจุบันของผู้ใช้ให้กับเครื่องโดยผู้ใช้เอง โดยควรเป็นค่าที่
อ้างอิงกับระดับทะเลปานกลาง (Barometric pressure adjusted to sea level) ซึ่งจะท าให้ค่าความสูงที่
อ่านได้เป็นค่าความสูงเหนือระดับทะเลปานกลาง และสามารถใช้กับแผนที่ภูมิประเทศได้โดยตรง ทั้งนี้ ค่า
ความดันบรรยากาศที่อ้างอิงกับระดับทะเลปานกลางอาจจะได้มาจากสนามบินในบริเวณนั้น อย่างไรก็ตาม ถ้า
ผู้ใช้อยู่ห่างจากสนามบินมาก และมีความแตกต่างของระดับความสูงและสภาพลมฟ้าอากาศระหว่างสนามบิน
กับต าแหน่งของผู้ใช้มาก จะท าให้การสอบเทียบลักษณะนี้มีความคลาดเคลื่อนสูง 

การปรับตั้งเครื่องวัดความสูงจากความดันบรรยากาศ มีขั้นตอนดังนี้ 
1) ให้ผู้ใช้ไปอยู่ ณ ต าแหน่งที่ทราบค่าความสูงหรือค่าความดันบรรยากาศที่ถูกต้อง 
2) เปิดหน้า Profile ผังความสูง (Elevation Plot) 
3) กดปุ่ม MENU เลือก ปรับต้ังเครื่องวัดความสูง (Calibrate Altimeter) 
4) ปฏิบัติตามขั้นตอนบนหน้าจอ 

16. การวาดผังความสูง (Elevation Plot) 
ด้วยค่าโดยปริยายของเครื่อง เครื่องจะแสดงผังความสูงตามระยะทาง (Elevation / Distance) ทั้งนี้ 

ผู้ใช้สามารถเปลี่ยนแปลงประเภทของผังความสูง การดูรายละเอียดเกี่ยวกับจุดบนแผนภูมิ และการตั้งค่า 
Profile ผังความสูงใหม่ได้ดังนี ้

16.1 การเปลีย่นประเภทของผัง (Plot Type) 
ผู้ใช้สามารถเปลี่ยนประเภทของการวาดผังความสูง  โดยก าหนดให้ผังแสดงข้อมูลความดัน 

(Pressure) ความสูง (Elevation) เวลา (Time) หรือระยะทาง (Distance) ได ้โดยมีขั้นตอนดังนี ้
1) เปิดหน้า Profile ผังความสูง (Elevation Plot) 
2) กดปุ่ม MENU เลือก เปลี่ยนประเภทแผนภูมิ (Change Plot Type) 

                                           
25

 โดยทั่วไป เครื่องรับสัญญาณระบบดาวเทียมน าร่องสามารถค านวณค่าความสูงได้ แต่จะเป็นค่าความสูงทรงรี (Ellipsoidal height) ที่อยู่ในมูล

ฐาน WGS 1984  และมีระดับความถูกต้องทางดิ่ง (Vertical accuracy) ต่ ากว่าเป็น 2 – 3  เท่า ของระดับความถูกต้องทางราบ (Horizontal 

accuracy) 
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3) เลือกตัวเลือกที่ต้องการ ซึ่งได้แก่ ความสูง / เวลา (Elevation / Time), ความสูง / ระยะทาง 
(Elevation / Distance), หน่วยวัดความกดอากาศ (Barometric Pressure) หรือ ความกดอากาศล้อมรอบ 
(Ambient Pressure) 

16.2 การดูรายละเอียดเกี่ยวกับจุดบนแผนภูม ิ

ผู้ใช้สามารถกดปุ่ม IN หรือ OUT เพื่อซูมเข้า/ออก หรือกดปุ่ม เพื่อเลื่อนไปต าแหน่ง
ต่าง ๆ บนผังความสูง เพื่อดูรายละเอียดข้อมูลเกี่ยวกับจุด ที่แสดงบริเวณด้านบนของแผนภูมิ หรือกดปุ่ม 
ENTER เพื่อดูรายละเอียดข้อมูล ณ ต าแหน่งของจุดบนแผนภูมิ 

16.3 การตั้งค่า Profile ผังความสูงใหม่ (Resetting the Elevation Plot) 
1) เปิดหน้า Profile ผังความสูง (Elevation Plot) 
2) กดปุ่ม MENU เลือก ตั้งใหม่ (Reset) 
3) เลือก ลบ Track ปัจจุบัน > ใช่ (Clear Current Track > Yes) 

17. ข้อมูลการเดินทาง (Trip computer) 
ข้อมูลการเดินทาง คือ ข้อมูลที่ค านวณจากการที่ผู้ใช้ได้ใช้งานเครื่องระหว่างการเดินทาง ซึ่งมีข้อมูล

เกี่ยวกับความเร็วปัจจุบัน ความเร็วเฉลี่ย ความเร็วสูงสุด ระยะทาง และสถิติอื่น ๆ ที่เป็นประโยชน์ต่อผู้ใช้ ทั้งนี้ 
ผู้ใช้สามารถตั้งค่าผัง (Layout) แผงหน้าปัด (Dashboard) และข้อมูลสถิติต่าง ๆ (Data field) ได้โดยมี
ขั้นตอนดังนี้ 

17.1 การตั้งค่าข้อมูลการเดินทางใหม่26  (Resetting) 
1) เปิดหน้า Trip Computer 
2) กดปุ่ม MENU เลือก ตั้งใหม่ > ตั้งข้อมูลเดินทางใหม่ > ใช่ (Reset > Reset Trip Data > Yes) 
เมื่อตั้งค่าข้อมูลการเดินทางใหม่ ค่าของ Trip Computer ทั้งหมด จะถูกปรับเป็นศูนย์ ทั้งนี้ ก่อน

เริ่มการเดินทางทุกครั้ง ควรตั้งค่าข้อมูลการเดินทางใหม่ทุกครั้ง 

17.2 การเปลีย่นขนาดข้อความที่แสดงผลข้อมูลการเดินทาง 
1) เปิดหน้า Trip Computer 
2) กดปุ่ม MENU เลือก เลขขนาดใหญ่ (Big Numbers) เพื่อเปลี่ยนขนาดข้อความให้ใหญ่ขึ้น หรือ

เลือก เลขขนาดเล็ก (Small Numbers) เพื่อเปลี่ยนขนาดข้อความให้เล็กลง 

17.3 การตั้งค่าการแสดงผลข้อมูลการเดินทาง (Data Fields) 
1) เปิดหน้า Trip Computer 

                                           
26

 การตั้งค่าข้อมูลการเดินทางใหม่ สามารถท าได้อีกวิธีโดยการเลือก ตั้งค่า > ตั้งค่าใหม่ >  ตั้งข้อมูลเดินทางใหม่  > ใช ่(Setup > Reset > Reset 

Trip Data > Yes) 
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2) กดปุ่ม MENU เลือก เปลี่ยน Data Fields (Change Data Fields)  

3) กดปุ่ม เพื่อเลื่อนไปต าแหน่งของช่องแสดงข้อมูลการเดินทางที่ต้องการเปลี่ยนแปลง 
และกดปุ่ม Enter 

4) กดปุ่ม  เพื่อเลื่อนไปข้อมูลการเดินทางที่ต้องการแสดงข้อมูลในแผงหน้าปัด และกดปุ่ม 
Enter 

17.4 การตั้งค่าแผงหน้าปัด (Dashboard) 
เครื่อง Garmin รุ่น GPSMAP® 64s แสดงข้อมูลการเดินทางโดยใช้แผงหน้าปัด ซึ่งสามารถปรับเปลี่ยน

ได้หลากหลายแบบตามความเหมาะสมของกิจกรรมขณะที่ก าลังใช้งานเครื่อง การตั้งค่าแผงหน้าปัดมีขั้นตอน
ดังนี้ 

1) เปิดหน้า Trip Computer 
2) กดปุ่ม MENU เลือก เปลี่ยน Dashboard (Change Dashboard) 
3) เลือกแบบแผงหน้าปัดตามความต้องการของผู้ใช ้

18. การใช้เครื่องคดิเลข 
ผู้ใช้สามารถใช้เครื่องคิดเลขเพื่อค านวณค่าต่าง ๆ ได้ ซึ่งเครื่องมีโปรแกรมเครื่องคิดเลขทั้งแบบ

มาตรฐาน (Standard calculator) และแบบวิทยาศาสตร์ (Scientific calculator) และสามารถค านวณค่า
มุมได้ทั้งองศาและเรเดียน การใช้เครื่องคิดเลขมีขั้นตอนดังนี ้

1) เปิดหน้า เมนูหลัก (Main Menu) 
2) เลือก เครื่องคิดเลข (Calculator) 
3) เลือกตัวเลือกการใช้งานเครื่องคิดเลข ดังต่อไปนี ้

  เลือกประเภทของเครื่องคิดเลข โดยกดปุ่ม MENU และเลือก มาตรฐาน (Standard) หรือ ตาม
หลักวิทยาศาสตร์ (Scientific) (เครื่องคิดเลขแบบมาตรฐานเป็นค่าโดยปริยายของเครื่อง) 

  เลือกประเภทมุมในการค านวณ โดยกดปุ่ม MENU และเลือก องศา (Degrees) หรือ เรเดียน 
(Radians) 

19. การดูปฏิทิน 
1) เปิดหน้า เมนูหลัก (Main Menu) 
2) เลือก ปฏิทนิ (Calendar) 

ผู้ใช้สามารถเลือ่นไปดูวันและเดือนอื่น ๆ ในปฏิทินได้โดยกดปุ่ม กดปุ่ม  

20. การดูข้อมูลดวงอาทิตย์และดวงจันทร์ขึ้น-ลง 
1) เปิดหน้า เมนูหลัก (Main Menu) 
2) เลือก พระอาทิตย์และพระจันทร ์(Sun and Moon) 
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เมื่อผู้ใช้สามารถเลื่อนไปดูข้อมูลดวงอาทิตย์และดวงจันทร์ขึ้น-ลง และรูปกราฟิกแสดงลักษณะข้างขึ้น

ข้างแรมของดวงจันทร์ ของวันอื่น ๆ ได้โดยการกดปุ่ม  

21. การเพิ่มข้อมูลภาพแรสเตอรแ์บบ Custom Maps 
การเพิ่มข้อมูลภาพแรสเตอร์ เช่น ภาพแผนที่ที่ได้จากการกราดภาพ ภาพแผนผังแบบดิจิทัล หรือภาพ

จากดาวเทียม เป็นกระบวนการน าข้อมูลภาพแผนที่ไปจัดเก็บในอุปกรณ์ในลักษณะ “Custom Map” ซึ่งต้อง
เป็นข้อมูลภาพที่มีการก าหนดระบบพิกัดแผนที่ไว้แล้ว (Georeferenced image) ส าหรับอุปกรณ์ของ 
Garmin ที่รองรับการใช้งานแผนที่แบบ Custom Maps ได้แก่ Alpha™, Astro®, Dakota®, Colorado®, 
Oregon®, GPSMAP® 62 series, GPSMAP® 64 series, GPSMAP® 78 series, Edge® 800, Edge 
810, Edge 1000, Edge Touring Plus, Montana®, Rino®, eTrex® Touch series, eTrex® 20 and 
30 และ zumo 590LM 

ในการน าข้อมูลภาพมาใช้งาน ผู้ใช้ต้องตรวจสอบลิขสิทธิ์หรือเงื่อนไขการใช้งานข้อมูลอย่างละเอียดทุก
ครั้ง ก่อนที่จะน าข้อมูลมาใช้งาน โดยเฉพาะอย่างยิ่ง ข้อมูลประเภทภาพดาวเทียมที่ดาวน์โหลดมาจาก
อินเทอร์เน็ต 

ส าหรับตัวอย่างน้ีจะสาธิตการใช้งาน Custom Map โดยการน าข้อมูลภาพแผนที่ภูมิประเทศที่ได้จาก
การกราดภาพ มาเพิ่มลงในอุปกรณ ์เพื่อจัดเตรียมข้อมูลส าหรับการออกส ารวจหรือเก็บข้อมูลในพื้นที่ศึกษา ซึ่ง
มีขั้นตอนดังนี ้

1) น าแผนที่ภูมิประเทศมากราดภาพ และบันทึกข้อมูลภาพในรูปแบบ JPEG ทั้งนี้ แฟ้มข้อมูลภาพควรมี
ขนาดไม่เกิน 3 MB มีจ านวนจุดภาพไม่เกิน 1 ล้านจุดภาพ และมีความละเอียดประมาณ 130 จุดต่อนิ้ว (Dots 
Per Inch: DPI) (รูปที่ 8) 

 

 
รูปที่ 8 รูปภาพแผนที่ภูมิประเทศที่ได้มาจากการกราดภาพ 
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2) เปิดโปรแกรม Google Earth27 และคลิกปุ่ม Add > Image Overlay (รูปที่ 9) 
 

  
รูปที่ 9 การเพ่ิม Image Overlay 

 
3) ในหน้าต่าง New Image Overlay ให้ก าหนดข้อมูลต่าง ๆ ดังนี้ (รูปที่ 10) 

 ก าหนดชื่อ Image Overlay ในช่อง Name 

 คลิกปุ่ม Browse และเลือกต าแหน่งที่จัดเก็บข้อมูลรูปภาพแผนที่ภูมิประเทศ ในช่อง Link 

 ก าหนดความโปร่งใสของ Image Overlay ให้มีระดับประมาณร้อยละ 20 เพื่อท าให้ผู้ใช้สามารถ
มองเห็นข้อมูลภาพดาวเทียมเมื่อมีการวางซ้อนข้อมูลรูปภาพแผนที่ภูมิประเทศ 

  คลิกแท็บ Altitude และก าหนดค่าในช่อง Draw Order เพื่อก าหนดล าดับของการวางซ้อนแผน
ที่ใน Custom Map ทั้งนี้ การแสดงข้อมูลแผนที่ของอุปกรณ์จะเรียงล าดับตามค่า Draw Order โดยจะ
เรียงล าดับจากน้อยไปหามาก ดังนั้น ค่าที่มากที่สุดจะถูกแสดงผลบนแผนที่อื่น ๆ ที่มี ค่า Draw Order  ที่ต่ า
กว่า กล่าวอีกนัยหนึ่งคือ แผนที่นั้นจะวางซ้อนทับบนแผนที่อื่น ๆ  

                                           
27

 ผู้ใช้สามารถดาวน์โหลดและศึกษารายละเอียดการติดต้ังและใช้งานโปรแกรม Google Earth เพิ่มเติมได้ท่ี https://www.google.com  
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รูปที่ 10 การก าหนดค่า Image Overlay 

 
4) ปรับรายละเอียดบนรูปภาพแผนที่ภูมิประเทศ28 เช่น เส้นถนน และรายละเอียดอื่น ๆ ให้มีต าแหน่ง

ของรายละเอียดตรงกับรายละเอียดบนภาพถ่ายดาวเทียม โดยใช้การคลิกและลากเครื่องหมายสีเขียวที่ปรากฏ
บริเวณมุมและขอบภาพเพื่อย่อ/ขยาย (Scaling) หรือใช้เครื่องหมายสีเขียวที่ปรากฏกึ่งกลางภาพเพื่อเลื่อน
ภาพ (Translating)  ภาพ  หรือใช้เครื่องหมายรูปข้าวหลามตัดสีเขียว (Diamond shape) ที่ปรากฏบนภาพ
เพื่อหมุนรูปภาพ (Rotating) (รูปที่ 11) 

ผู้ใช้อาจจะต้องปรับความโปร่งใสของข้อมูลภาพให้เหมาะสม เพื่อท าให้การปรับรายละเอียดง่ายมากขึ้น 
เมื่อปรับรายละเอียดเสร็จแล้วให้คลิดปุ่ม Ok ในหน้าต่าง Edit Image Overlay 

                                           
28

 การปรับรายละเอียดของข้อมูลรูปภาพแผนที่ให้มีรายละเอียดตรงกับข้อมูลภาพเป็นกระบวนการก าหนดค่าพิกัดภาพ (Georeferencing) 
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รูปที่ 11 การก าหนดค่าพิกัดภาพของ Image Overlay 

 
5) ส่งข้อมูล Custom Map ไปจัดเก็บในอุปกรณ์ โดยการเชื่อมต่อเข้ากับอุปกรณ์เข้ากับคอมพิวเตอร์ 

โดยใช้สาย USB จากนั้น คลิกขวาไปยัง Custom Map ที่ได้จัดท าไว้ คลิก Save Place As โดยเลือกบันทึก
ข้อมูลในโฟลเดอร์ /Garmin/CustomMaps/29 ด้วยรูปแบบแฟ้มข้อมูล kmz จากนั้นคลิกปุ่ม Save (รูปที่ 12) 

 

 

รูปที่ 12 การบนัทึกข้อมูลภาพแรสเตอร์แบบ Custom Maps จาก Google Earth ลงเครื่อง GPSMAP® 64s 

                                           
29

 ถ้าหน่วยจัดเก็บข้อมูลในอุปกรณ์ไม่มีโฟลเดอร์ CustomMaps  ให้ผู้ใช้สร้างโฟลเดอร์ด้วยตนเอง 
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โดยปกติแล้ว Custom Map ที่เพิ่มเข้าไปในอุปกรณ์ จะแสดงผลอัตโนมัติหลังจากที่เปิดเครื่อง30 (รูปที่ 
13) 

 
 
 
 
 
 
 
 
 
 

รูปที่ 13 Custom Map ที่เปิดใช้งานในหน้าแผนที ่
 
ผู้ใช้สามารถตั้งค่าการเปิด/ปิดการใช้งาน Custom Maps ได้โดยเลือก ตั้งค่า > แผนที่ > ข้อมูลแผนที่ 

> Custom Maps (Setup > Map > Map Information > Custom Maps) จากนั้นเลือกรายการ 
Custom Map เพื่อเลือกเปิด/ปิดการใช้งาน Custom Map (รูปที่ 14) 

 
 
 
 
 
 
 
 
 
 
 

                                           
30

 ถ้าแผนที่แบบ Custom Map ที่เพิ่มลงในอุปกรณ์ มีขนาดแฟ้มข้อมูลภาพเกิน 3 MB หรือมีจ านวนจุดภาพเกิน 1 ล้านจุดภาพ เครื่องจะไม่

สามารถโหลดมาท างานได้ และจะขึ้นข้อความ “An image file in a Custom Map is too big. Images that are too big will not be on the map.” ทั้งนี้ 
ผู้ใช้สามารถปรับลดขนาดแฟ้มข้อมูลลง หรือแบ่งภาพออกเป็นหลาย ๆ ส่วนได้ อย่างไรก็ตาม การเพิ่มแผนที่แบบ Custom Map ลงในอุปกรณ์
มาก จะท าให้เครื่องท างานช้าลง  

Custom Map ที่แสดงในหน้าแผนที ่

Custom Map ทีไ่ม่ได้ใช้งาน 

Custom Map ทีใ่ช้งาน 
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รูปที่ 14 การเปิด/ปิดการใช้งาน Custom Maps 

22. การน าข้อมูลไปใช้ในโปรแกรมระบบสารสนเทศภูมิศาสตร์ 
 เครื่อง Garmin รุ่น GPSMAP® 64s สามารถเชื่อมต่อกับเครื่องคอมพิวเตอร์ได้โดยใช้สาย USB 

เชื่อมต่อระหว่างพอร์ต USB ของคอมพิวเตอร์กับพอร์ต Mini-USB ของเครื่อง ทั้งนี้ การต่อพ่วงสาย USB หรือ

การใช้ USB Hub อาจจะท าให้มีพลังงานไม่เพียงพอต่อการท างานของเครื่อง GPSMAP® 64s ดังนั้น เมื่อต่อ

พ่วงสาย USB หรือการใช้ USB Hub จึงต้องใส่แบตเตอรีไ่ว้ในเครื่องทุกครั้ง 

การน าข้อมูลไปใช้ในโปรแกรมระบบสารสนเทศภูมิศาสตร ์มีขั้นตอนดังนี ้

1) เปิดฝาปิดพอร์ต Mini-USB 

2) เสียบสาย USB เชื่อมต่อพอร์ต USB ของคอมพิวเตอร์กับพอร์ต Mini-USB ของเครื่อง 

ในระบบปฏิบัติการ Window จะแสดงหน่วยจัดเก็บข้อมูลและการ์ดข้อมูล microSD™ card ที่อยู่ใน

เครื่อง GPSMAP® 64s เป็น Removable Storage หรือ Portable Device ซึ่งท าให้เครื่องคอมพิวเตอร์

สามารถเข้าถึงข้อมูลภายในอุปกรณ์ได้โดยตรง (รูปที่ 15) 

  

รูปที่ 15 ไดรฟ์ของเครื่อง GPSMAP® 64s ที่เชื่อมต่อกับเครื่องคอมพิวเตอร ์

การเปิดใช้งาน Custom Map การปิดใช้งาน Custom Map 
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 ข้อมูล Waypoint, Track, และ Route จะถูกจัดเก็บอยู่ใน X:\Garmin\GPX โดยที่ X คือ อักษรระบุ
ไดรฟ์ของอุปกรณ ์(รูปที่ 16) 

  

รูปที่ 16 ต าแหน่งเก็บข้อมูลในไดรฟ์ของเครื่อง GPSMAP® 64s 

แฟ้มข้อมูลจะอยู่ในรูปแบบ *.gpx ซึ่งโปรแกรมระบบสารสนเทศภูมิศาสตร์ส่วนใหญ่รองรับการท างาน 
และสามารถเปิดใช้งานได้โดยตรง  

3) คัดลอกแฟ้มข้อมูล GPX ที่ต้องการมาจัดเก็บไว้ในคอมพิวเตอร์ ในตัวอย่างนี้ ได้คัดลอกข้อมูลจาก
โฟลเดอร์ X:\Garmin\GPX\Current มาจัดเก็บยัง D:\GPX 

4) เปิดข้อมูล GPX ที่คัดลอกมาจัดเก็บไว้ในคอมพิวเตอร์ด้วยโปรแกรม QGIS รุ่น 2.8.331 ซึ่งเป็น
ซอฟต์แวร์รหัสเปิด (Open-source software) (รูปที่ 17) 

 

รูปที่ 17 การเปิดข้อมูล GPX ด้วยโปรแกรม QGIS 
                                           
31

 ผู้ใช้สามารถดาวน์โหลดและศึกษารายละเอียดการติดต้ังและใช้งานโปรแกรม QGIS เพิ่มเติมได้ท่ี www.qgis.org  
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5) เลือกประเภทข้อมูล Waypoint, Track, หรือ Route จากแฟ้มข้อมลู GPX (รูปที่ 18) 

 

รูปที่ 18 การเลือกประเภทข้อมูล Waypoint, Track, หรือ Route จากแฟ้มข้อมูล GPX 

 ข้อมูล Waypoint, Track, หรือ Route ที่ถูกเลือกจะแสดงเป็นชั้นข้อมูลในโปรแกรม โดยข้อมูล 

Waypoint แสดงเป็นชั้นข้อมูลจุด (Point layer)  ส่วน Track และ Route แสดงเป็นชั้นข้อมูลเส้น (Line 

layer)  ทั้งนี้ ผู้ใช้สามารถน าข้อมูลมาประมวลผลวิเคราะห์หรือจัดท าแผนที่ได้ (รูปที่ 19) 

 

รูปที่ 19 ข้อมูล Waypoint, Track, หรือ Route ที่แสดงเป็นช้ันข้อมูลในโปรแกรม QGIS 

23. การใช้งาน GPSMAP® 64s แบบ Real-time ในโปรแกรม QGIS 
การแสดงผลข้อมูลต าแหน่งของเครื่องรับสัญญาณระบบดาวเทียมน าร่องแบบทันที (Rea-time) ใน

ซอฟต์แวร์ระบบสารสนเทศภูมิศาสตร์ จะท าให้ผู้ใช้สามารถบูรณาการข้อมูลเชิงพื้นที่ในด้านต่าง ๆ เช่น ข้อมูล

ทางธรณีวิทยา ข้อมูลดิน ข้อมูลการใช้ที่ดิน ข้อมูลปริมาณน้ าฝน ข้อมูลรูปถ่ายทางอากาศ ข้อมูลภาพดาวเทียม 
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ฯลฯ จากฐานข้อมูลภูมิสารสนเทศได้ ซึ่งจะช่วยให้การศึกษาวิจัยหรือปฏิบัติงานในภาคสนามมีประสิทธิภาพ

มากขึ้น 

การใช้งานเครื่อง GPSMAP® 64s เพื่อแสดงต าแหน่งแบบทันทีในโปรแกรม QGIS มีรายละเอียดดังนี ้

23.1 การจัดเตรียมอุปกรณแ์ละซอฟต์แวร์ 
รายการอุปกรณ ์

o เครื่อง GPSMAP® 64s 
o โน้ตบุ๊กคอมพิวเตอร์ 
o สาย USB ที่ใช้เชื่อมต่อระหว่างพอร์ต Mini-USB ของเครื่อง GPSMAP® 64s กับพอร์ต 

USB ของโน้ตบุ๊กคอมพิวเตอร์ 
รายการซอฟต์แวร ์

o Garmin USB Driver version 2.3.1.132 
o GpsGate Splitter33 (ชื่อเดิมคือ GpsGate Client)  
o โปรแกรม QGIS รุ่น 2.8.334 

23.2 การใช้งานเครื่อง GPSMAP® 64s แบบ Real-time ในโปรแกรม QGIS 
1) ติดตั้งโปรแกรม Garmin USB Driver  GpsGate Splitter  และโปรแกรม QGIS รุ่น 2.8.3 ใน

โน้ตบุ๊กคอมพิวเตอร์ 
2) เปิดเครื่อง GPSMAP® 64s และตั้งค่าการเชื่อมต่อและส่งข้อมูล (Interface) ของเครื่อง 

GPSMAP® 64s เป็นแบบ Garmin Spanner โดยเลือก ตั้งค่า > ระบบ > การเชื่อมต่อ > Garmin Spanner 
(Setup > System > Interface > Garmin Spanner (รูปที่ 20) 

 
 
 
 
 
 
 
รูปที่ 20 การต้ังค่าการเช่ือมต่อและส่งข้อมูล (Interface) ของเครื่อง GPSMAP® 64s 

                                           
32

 ผู้ใช้สามารถดาวน์โหลดและศึกษารายละเอียดการติดต้ัง Garmin USB Driver เพิ่มเติมได้ที่ http://www.garmin.com  
33

 ผู้ใช้สามารถดาวน์โหลดและศึกษารายละเอียดการติดต้ังและใช้งานโปรแกรม GpsGate Splitter เพิ่มเติมได้ที่ http://gpsgate.com  
34

 ผู้ใช้สามารถดาวน์โหลดและศึกษารายละเอียดการติดต้ังและใช้งานโปรแกรม QGIS เพิม่เติมได้ท่ี www.qgis.org  
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2) เชื่อมต่อสาย USB กับเครือ่ง GPSMAP® 64s และโน้ตบุ๊กคอมพิวเตอร์ (รูปที่ 21) 
 

 

รูปที่ 21 การเช่ือมต่อสาย USB กับเครื่อง GPSMAP® 64s และโน้ตบุ๊กคอมพิวเตอร์ 
 
3) หลังจากการเชื่อมต่อเครื่อง GPSMAP® 64s กับโน้ตบุ๊กคอมพิวเตอร์ จะมีข้อความแสดงบน

เครื่อง GPSMAP® 64s ว่า “พบหน่วยความจ าภายนอก ต้องการใช้งานหรือไม่” (“USB cable detected. 
Would you like to go to Mass Storage”) ให้ผู้ใช้เลือก “ไม่” (“No”) เพื่อให้เครื่องยังคงรับสัญญาณ
ดาวเทียมระหว่างที่เชื่อมต่อกับโน้ตบุ๊กคอมพิวเตอร์ 

4) เปิดโปรแกรม GpsGate คลิปปุ่ม Advanced จากนั้นคลิกแท็บ Input เลือก Garmin USB และ
คลิกปุ่ม Open เพื่อรับข้อมูลจากเครื่อง GPSMAP® 64s (รูปที่ 22) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. คลิกแท็บ Input 

2. คลิกเลือก Garmin USB 

3. คลิกปุ่ม Open 

ก่อนคลิกปุ่ม Open ไอคอน
เป็นสีแดงแสดงสถานภาพการ
รับข้อมูลยงัคงปิด (Closed) 
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รูปที่ 22 การต้ังค่าแท็บ Input และเปิดการรับข้อมูลจากเครื่อง GPSMAP® 64s ในโปรแกรม GpsGate 
 
5) ตั้งค่าแท็บ Output ในโปรแกรม GpsGate เพื่อก าหนดช่องทางการส่งข้อมูลจากเครื่อง 

GPSMAP® 64s ไปยังโปรแกรม QGIS (รูปที่ 23) 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 23 การต้ังค่าแท็บ Output ส าหรับการส่งข้อมูลออกจากเครื่อง GPSMAP® 64s ในโปรแกรม GpsGate 
 
6) เปิดใช้งาน GPS Tools plugin ในโปรแกรม QGIS โดยคลิกเมนู Plugins > Manage and 

Install Plugins… จากนั้นคลิกกล่องเลือก GPS Tools ให้มีเครื่องหมายกาบาท และคลิกปุ่ม Close (รูปที่ 24) 
 

หลังคลิกปุ่ม Open ไอคอนเป็นสี
เขียวแสดงสถานภาพการรบั

ข้อมูลพร้อมใช้งาน (Running 
OK!) 

หลังคลิกปุ่ม Open  
ปุ่มจะสลับเป็นปุ่ม Close 

ช่องทางการสง่ข้อมูล
ไปยังโปรแกรม QGIS 

หลังคลิกปุ่ม Add 

1. คลิกแท็บ Output 

2. คลิกเลือก Virtual COM Port 

3. คลิกปุ่ม Add 
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รูปที่ 24 การเปิดใช้งาน GPS Tools plugin ในโปรแกรม QGIS 

เมื่อผู้ใช้เปิดการใช้งาน GPS Tools plugin ในโปรแกรม QGIS แล้ว จะปรากฏปุ่มที่มีไอคอนรูป

เครื่องรับสัญญาณระบบดาวเทียมน าร่องในแถบเครื่องมือ และจะมีเมนูย่อย Layer > Create layer > 

Create new GPX layer (รูปที่ 25) 

 

 

 

 

 

รูปที่ 25 ไอคอนและเมนูย่อยของ GPS Tools plugin ในโปรแกรม QGIS 

7) เปิดแผงควบคุมข้อมูลจีพีเอส โดยคลิกเมนู View > Panels > GPS Information (รูปที่ 26) 

 

 

 

การเปิดใช้งาน GPS Tools plugin 

ไอคอนของ GPS Tools plugin 

เมนูย่อยของ GPS Tools plugin 
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รูปที่ 26 การเปิดแผงควบคุมข้อมูลจีพีเอสในโปรแกรม QGIS 

8) สร้างชั้นข้อมูล GPX35 ส าหรับการน าเข้าข้อมูลจุด หรือเส้นระหว่างการใช้งานเครื่อง GPSMAP® 

64s แบบ Real-time ในโปรแกรม QGIS โดยการคลิกเมนู Layer > Create Layer > Create GPX layer 

จากนั้นก าหนดสถานที่จัดเก็บและชื่อแฟ้มข้อมูลแล้วคลิกปุ่ม Save (รูปที่ 27) 

 

รูปที่ 27 การสร้างชั้นข้อมูล GPX ส าหรับการน าเข้าข้อมูลในโปรแกรม QGIS 

                                           
35

 แฟ้มข้อมูล GPX จัดเก็บข้อมูล Waypoint, Route และ Track ทั้งหมดรวมในแฟ้มข้อมูลเดียวกัน แต่แฟ้มข้อมูล GPX ที่เปิดในโปรแกรม QGIS จะ

แสดงข้อมูล Waypoint, Route และ Track แยกเป็นชั้นข้อมูลออกจากกัน 

การเปิด GPS Information panel 

GPS Information panel 

1. คลิก Create new GPX layer 

2. ก าหนดสถานที่จัดเก็บข้อมูล 

3. ก าหนดชื่อแฟ้มข้อมูล 

4. คลิกปุ่ม Save MAHID
OL
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9) เปิดโหมดแก้ไขข้อมูลส าหรับการน าเข้าข้อมูล โดยการคลิกขวาที่ชั้นข้อมูล แล้วเลือก Toggle 

Editing ซึ่งจะท าให้ไอคอนของชั้นข้อมูลจะปรากฏเป็นรูปดินสอ ในตัวอย่างนี้ จะเปิดโหมดการแก้ไขข้อมูล

ประเภทจุด (Waypoint) เพื่อให้สามารถน าเข้าข้อมูลจุดโดยใช้ค่าพิกัดที่ได้รับจากเครื่อง GPSMAP® 64s (รูป

ที่ 28) 

 

 

 

 

รูปที่ 28 การเปิดโหมดแก้ไขข้อมูลในโปรแกรม QGIS 

10) เชื่อมต่อโปรแกรม QGIS ให้รับข้อมูลจากเครื่อง GPSMAP® 64s โดยคลิกเลือก Autodetect 

ในกรอบ Connection จากนั้นคลิกปุ่ม Connect ใน GPS Information panel (รูปที่ 29) 

 

 

 

 

 

 

รูปที่ 29 การเช่ือมต่อโปรแกรม QGIS ให้รับข้อมูลจากเครื่อง GPSMAP® 64s 

เมื่อการเชื่อมต่อส าเร็จ แถบสถานภาพการเชื่อมต่อจะปรากฏเป็นสีเขียว ผู้ใช้สามารถตรวจสอบ

1) ข้อมูลต าแหน่งที่ได้รับจากเครื่อง GPSMAP® 64s โดยการคลิกไอคอนรูปดินสอ 2) ความแรงของสัญญาณ

ดาวเทียม โดยการคลิกไอคอนรูปแผนภูมิแท่ง 3) ต าแหน่งของดาวเทียมที่สามารถรับสัญญาณได้ โดยการคลิก

ไอคอนรูปแผนที่เชิงขั้ว และ 4) การต้ังค่าตัวเลือกต่าง ๆ โดยการคลิกไอคอนรูปประแจ (รูปที่ 30) 

เปิดโหมดแก้ไขข้อมูล 

1. คลิกเลือก Autodetect 

2. คลิกปุ่ม Connect 

สถานภาพการเชื่อมต่อส าเรจ็จะปรากฏแถบสีเขียว 
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รูปที่ 30 การตรวจสอบต าแหน่งและความแรงของสัญญาณดาวเทียม 

เมื่อผู้ใช้เคลื่อนที่ ข้อมูลที่ได้รับจากเครื่อง GPSMAP® 64s จะถูกน ามาแสดงในโปรแกรม QGIS 

แบบ Real-time (รูปที่ 31) 

 

รูปที่ 31 การแสดงข้อมูลจากเครื่อง GPSMAP® 64s จะถูกน ามาแสดงในโปรแกรม QGIS แบบ Real-time 

11) การเปิดโหมดการแก้ไขข้อมูลประเภทจุด (Waypoint) จะท าให้ปุ่ม Add Point ใน GPS 

Information panel พร้อมใช้งาน เมื่อผู้ใช้ต้องการน าเข้าข้อมูลจุด เช่น จุดเก็บตัวอย่างข้อมูลมลพิษอากาศ 

ผู้ใช้สามารถคลิกปุ่ม Add Point และตั้งชื่อจุด จากนั้นคลิกปุ่ม OK จะท าให้ข้อมูลค่าพิกัดที่อ่านได้จาก

เครื่องรับสัญญาณระบบดาวเทียมน าร่องถูกน าเข้า และถูกบันทึกสู่ชั้นข้อมูลแบบอัตโนมัติ ตามค่าโดยปริยายที่

ก าหนดไว้ในกรอบ Digitizing ของ GPS Information panel (รูปที่ 32) 
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รูปที่ 32 การน าเข้าข้อมูลจุดจากเครื่องรับสัญญาณระบบดาวเทียมน าร่อง 

12) เมื่อผู้ใช้น าเข้าข้อมูลแล้ว และต้องการหยุดการน าเข้าข้อมูลในโปรแกรม QGIS ให้คลิกขวาที่ชั้น

ข้อมูล แล้วเลือก Toggle Editing (รูปที่ 33) 

 

 

 

 

รูปที่ 33 การปิดโหมดการแก้ไขข้อมูลในโปรแกรม QGIS 

13) เมื่อผู้ใช้ต้องการปิดการเชื่อมต่อโปรแกรม QGIS กับเครื่อง GPSMAP® 64s ให้ผู้ใช้คลิกปุ่ม 

Disconnect ใน GPS Information panel (รูปที่ 34) 

 

 

รูปที่ 34 การปิดการเช่ือมต่อโปรแกรม QGIS กับเครื่อง GPSMAP® 64s 

14) ภายหลังจากการหยุดน าเข้าข้อมูลและแสดงข้อมูลจากเครื่อง GPSMAP® 64s แบบ Real-

time ในโปรแกรม QGIS แล้ว ผู้ใช้สามารถปิดการใช้งานโปรแกรม QGIS โดยคลิกเมนู Project > Exit QGIS 

ทั้งนี้ ถ้าผู้ใช้ต้องการบันทึกข้อมูลโครงการ ซึ่งเป็นข้อมูลเกี่ยวกับรายละเอียดของโครงการ ตลอดจนสถานะการ

ท างานของผู้ใช้ เช่น ชื่อโครงการ หน่วยของระบบพิกัด ชั้นข้อมูลและคุณสมบัติของชั้นข้อมูลที่ก าลังใช้งานใน

1. คลิกปุ่ม Add Point 

2. ก าหนดชื่อจุด 

3. คลิกปุ่ม OK 

การปิดโหมดการแก้ไขข้อมูล 

การปิดการเชื่อมต่อข้อมูล 
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โครงการ พื้นที่แสดงผลข้อมูลแผนที่ ณ ปัจจุบัน รวมถึงการตั้งค่าต่าง ๆ ขณะท างานในโปรแกรม QGIS ให้ผู้ใช้

คลิกเมนู Project > Save Project ทั้งนี้ โปรแกรม QGIS จัดเก็บแฟ้มโครงการเป็นนามสกุล *.qgs 

15) ภายหลังจากการปิดการใช้งานโปรแกรม QGIS แล้ว ผู้ใช้ต้องปิดการรับข้อมูลจากเครื่อง 

GPSMAP® 64s โดยการเปิดโปรแกรม GpsGate คลิปปุ่ม Advanced จากนั้นคลิกแท็บ Input และคลิกปุ่ม 

Close (รูปที่ 35) 

 

 

 

 

 

 

 

 

รูปที่ 35 การปิดการรับข้อมูลจากเครื่อง GPSMAP® 64s ในโปรแกรม GpsGate 

16) ปิดเครื่อง GPSMAP® 64s ถอดสาย USB และปิดโน้ตบุ๊กคอมพิวเตอร์ รวมทั้งตรวจสอบและ

จัดเก็บอุปกรณ์ให้เรียบร้อย 

 

 

 

 

 

1. คลิกแท็บ Input 

2. คลิกปุ่ม Close 
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ภาคผนวก 

คุณลักษณะหรือสมรรถนะของเครื่อง (Specifications) 
คุณลักษณะ GPSMAP® 64s 

ขนาดเครื่อง WxHxD 6.1 x 16.0 x 3.6 ซม. 
ขนาดหน้าจอ WxH 3.6 x 5.5 ซม. (แนวทแยง 6.6 ซม.) 
ความละเอียดจอแสดงผล WxH 160 x 240 จุดภาพ 
ประเภทหน้าจอ Transflective สี 65-K TFT 
น ้าหนัก 8.1 ออนซ์ (230 ก.) พร้อมแบตเตอรี่ 
แบตเตอร์รี ่ AA 2 ก้อน (ควรใช้แบบ NiMH หรือ Lithium) 
อายุแบตเตอร์รี่ 16 ชม. 
การกันน ้า IPX7 

การลอยน ้า  
การรับสัญญาณไวสูง  
การเช่ือมต่อ USB และ NMEA 0183 compatible 
เครื่องมือวัดความสูงด้วยความดันบรรยากาศ  
เข็มทิศอิเล็กทรอนิกส์ (Tilt-compensated 3-axis)  
การถ่ายโอนข้อมูลจากเครื่องต่อเครื่องแบบไร้สายระหว่าง
เครื่องรุ่นเดียวกัน  

แผนที่มูลฐาน (Basemap)  
แผนที่มูลฐานเสริม (Preloaded maps)  
ความสามารถในการเพิ่มแผนที่  
หน่วยความจ้าในเครื่อง 4 GB 
การสนับสนุนการ์ดข้อมูล microSD™ card 
ความสามารถในการเพิ่มจุดสนใจ (Custom POIs)  
การบันทึก Waypoints 5,000 
การบันทึก Routes 200 
การบันทึก Track log 10,000 จุด บนัทึกได้ 200 Tracks 
การน้าทางอัตโนมัติ (Turn-by-turn routing)  
Geocaching  
การใช้งานแผนที่แรสเตอร์ (Custom maps compatible)  
ปฏิทินล่าสัตว์/ตกปลา  

MAHID
OL



คุณลักษณะ GPSMAP® 64s 
ข้อมูลดวงอาทิตย์และดวงจันทร ์  
ตารางน ้าขึ นลง  
การค้านวณพื นที่  
การดูรูปภาพ (Picture viewer)  
การใช้งาน Garmin Connect™  (Garmin Connect™ 
compatible)  

Smart Notifications  
Live Tracking (with Garmin Connect™ Mobile)  
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